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Preface
This guide contains information about installing Invoice Processing Agility and assumes that you have a
thorough understanding of Windows standards, applications, and interfaces, as well as Kofax TotalAgility.
This guide is for solution integrators who are installing Invoice Processing Agility or who need a
description of the installation procedures and requirements.

Related documentation
In addition to this Kofax Invoice Processing Agility Installation Guide, the following documentation is
available.
• The Kofax Invoice Processing Agility Administrator's Guide provides instructions for customizing Invoice
Processing Agility so that it meets your specific requirements.
• Help for Kofax Invoice Processing Agility Scan provides information on how to scan documents into
Invoice Processing Agility.
• Help for Kofax Invoice Processing Agility Validation provides information about validating a document in
Invoice Processing Agility.
Additional documentation about validating documents is available in the Help for Kofax TotalAgility
Validation.
• Help for Kofax Invoice Processing Agility Solution Configuration Manager provides detailed information
on how to configure Invoice Processing Agility for your environment.
• Help for Kofax Invoice Processing Agility Line Pairing Correction provides use cases and examples for
correcting a document that fails line pairing.
• Help for Kofax Invoice Processing Agility PIX Correction provides detailed information about how
to navigate through PIX Correction. It also includes details about how to use PIX Correction when
processing documents with Invoice Processing Agility.
For more information on how to access documentation, see Access Invoice Processing Agility
documentation.

Training
Kofax offers both classroom and computer-based training that will help you make the most of your Kofax
TotalAgility solution. Visit the Kofax website at http://www.kofax.com for complete details about the
available training options and schedules.

6

Kofax Invoice Processing Agility Installation Guide

Getting help for Kofax products
Kofax regularly updates the Kofax Support site with the latest information about Kofax products.
To access some resources, you must have a valid Support Agreement with an authorized Kofax Reseller/
Partner or with Kofax directly.
Use the tools that Kofax provides for researching and identifying issues. For example, use the Kofax
Support site to search for answers about messages, keywords, and product issues. To access the Kofax
Support page, go to www.kofax.com/support.
The Kofax Support page provides:
• Product information and release news
Click a product family, select a product, and select a version number.
• Downloadable product documentation
Click a product family, select a product, and click Documentation.
• Access to product knowledge bases
Click Knowledge Base.
• Access to the Kofax Customer Portal (for eligible customers)
Click Account Management and log in.
To optimize your use of the portal, go to the Kofax Customer Portal login page and click the link to
open the Guide to the Kofax Support Portal. This guide describes how to access the support site, what
to do before contacting the support team, how to open a new case or view an open case, and what
information to collect before opening a case.
• Access to support tools
Click Tools and select the tool to use.
• Information about the support commitment for Kofax products
Click Support Details and select Kofax Support Commitment.
Use these tools to find answers to questions that you have, to learn about new functionality, and to
research possible solutions to current issues.
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System requirements
Information about supported operating systems and other Invoice Processing Agility requirements is
available on the Kofax Support website.
For a list of supported operating systems, see the Technical Specification on the Kofax support website.

Software prerequisites
The software prerequisites required prior to the installation of Invoice Processing Agility, are listed as
follows.
Kofax TotalAgility 7.5.0
Kofax TotalAgility version 7.5.0 must be installed on the system when installing Invoice Processing Agility
1.1.0.
Internet Information Services
Prior to installing the Solution Configuration Manager for Invoice Processing Agility, you must install
Microsoft Internet Information Services (IIS) according to the instructions provided on the Microsoft
website. During the installation of IIS, make sure you install the following role services.
• Static Content
• Default Document
• Directory Browsing
• HTTP Errors
• ASP.NET 3.5
• ASP.NET 4.5
• .NET Extensibility 3.5 and 4.5
• HTTP Logging
• Request Monitor
For more information on installing and configuring IIS, refer to the Microsoft documentation.
SAP Client Component
If SAP support is required, download the "SAP .Net Connector x64 3.0.13.1" or newer from SAP. Also,
install the assemblies to GAC. (This is offered as an option during the installation.)
Oracle Client Component
If Oracle database access is required, install the Oracle Data Provider for .NET 2 (ODP.NET20) that you
can get from the Oracle website.
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Localize Invoice Processing Agility
The localization of Invoice Processing Agility is available for these languages.
• English
• French
• German
• Spanish
• Brazilian Portuguese
If the main language of your web browser is set to one of the above languages, the user interface
and documentation for Invoice Processing Agility appear in that language automatically. For any other
language, and for the administrative documentation, it defaults to English.
However, this localizes the Invoice Processing Agility activities only. Because Invoice Processing Agility
is a part of Kofax TotalAgility, it is necessary to install the TotalAgility language packs to ensure a fully
localized environment. For more information about localizing Kofax TotalAgility, refer to the Kofax
TotalAgility Installation Guide.
Note If you have upgraded Kofax TotalAgility from a previous version, the Workspace Package.zip file
is needed to install the Kofax TotalAgility 7.5 language packs. However, when you install the Kofax
TotalAgility Workspace Package.zip file, this also updates the TotalAgility theme. Unfortunately, this
updated theme is not supported by Invoice Processing Agility so it is necessary to change the theme to
the classic version.

Important installation notes
The following note is important when installing Invoice Processing Agility.
Administrator Rights
To install the product, the logged on user must have Administrator rights on the local computer.
Database Permissions
It is necessary that the users in the following areas have sufficient database permissions to perform their
tasks.
Installation
During installation, multiple databases are created or updated. It is necessary that the user specified
has the db_creator role to create a database or the db_owner role to update a database.
In addition to these roles, users must also have the Connect permission.
Configuration
It is necessary that the users who manage, maintain, and use both the Solution Configuration
Manager database and the Invoice Processing Agility client database have the db_datawriter and
db_datareader roles for the various databases.
In addition to these roles, users must also have the Connect and Execute permissions.
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If a user in one of these scenarios does not have the necessary database role or permissions, they cannot
successfully perform their tasks.

Invoice Processing Agility in an Azure environment
You can deploy Invoice Processing Agility into an Azure hosted Kofax TotalAgility environment. However,
there are some limitations using this method of deployment over a traditional installation.
• User exits are not supported.
•
•
•
•
•
•
•
•
•

SAP, Oracle, and MarkView integrations are not supported.
PIX is not supported so this means that you cannot process electronic XML invoices.
ERP data such as purchase order or company data, is provided by an ERP connector only.
Exporting to Process Director is not supported.
You cannot use Invoice Processing Agility integrated user management or client group assignments.
Some Solution Configuration Manager settings are not available for configuration.
PDF Generation is not supported.
Document Export is not supported.
Windows Authentication is not supported.

If you choose to use this deployment method, the Solution Configuration Manager is installed in the
on-premises environment. A set of database scripts and a Kofax TotalAgility package is provided for
installation into the cloud.
Since no assemblies can be installed on the Azure server, the package includes the following.
• The IPA.dll that contains all dependencies needed to run Invoice Processing Agility in the cloud.
• The Transformation Designer project that contains everything needed to run Invoice Processing Agility
in the cloud.
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Invoice Processing Agility installation
Invoice Processing Agility processes invoices by extracting and validating data on those documents. It
also performs line-pairing so that your back-end ERP system can assign a specific invoice line item to a
corresponding purchase order line item.
You can install Invoice Processing Agility on a system where Kofax TotalAgility is installed.
Important If you are using Oracle, ensure that you have installed the prerequisite client.
If you are using SAP, ensure that you have installed the prerequisite connector.
The following steps are for the overall installation of Invoice Processing Agility. Each step contains its own
set of instructions and the order is important. Skipping steps that are not optional, or performing steps out
of sequence can result in a failed installation.
1. Extract the zip file contents.
2. Run the Invoice Processing Agility Installer in one of the following modes.
• Full
• Custom
• Command Line or silent installation
3. Optionally, change your installation.
4. Configure your installation for your needs.

Extract the ZIP file
All of the installation files necessary to install Invoice Processing Agility are available in the
KofaxInvoiceProcessingAgility-1.1.0.zip file.
You can extract the contents of the ZIP file by following these steps.
1. Right-click on the zip file and select Extract.
2. When prompted, select a location for the extracted files.
Make a note of this location for further installation steps.

Install Invoice Processing Agility
How you install Invoice Processing Agility depends on your Kofax TotalAgility installation.
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In some environments, Kofax TotalAgility is installed on a single server. In other environments, Kofax
TotalAgility is distributed across multiple servers. Each environment requires a different approach when
installing Invoice Processing Agility.
To help with this, there are three different methods of installing Invoice Processing Agility.
Full
Use the full installation method when installing all Invoice Processing Agility features on the same
machine.
Custom
Use the custom installation method to install one or more of the individual Invoice Processing Agility
features.
Command Line/Silent Install
Use the command line silent installation method to install one or more of the individual Invoice Processing
Agility features. Use this method to install various features on multiple machines at one time, or across a
network.

Full installation
Use the full installer to install all available Invoice Processing Agility components.
These components include the following.
• Invoice Processing Agility Assemblies
These assemblies are installed on this server automatically whenever the Full installer is run. No
configuration is required.
• The following assemblies are installed on this server automatically if their prerequisite components
are found on this server.
• SAP Assemblies
• Oracle Assemblies
• MarkView Assemblies
Important If you are using MarkView, additional manual steps are required once the installer
is complete.
• Invoice Processing Agility Client Database Connection
• Kofax TotalAgility Integration
• Kofax TotalAgility Package
• Solution Configuration Manager
If you do not need all of these components use the Custom installation instead. This enables you to select
the specific component(s) that you require.
You can install all of the components for Invoice Processing Agility using the Setup Wizard by following
these steps.
1. Navigate to your extracted files and open the Installer folder.
The contents of the Installer folder are displayed.
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2. Double-click on the Kofax Invoice Processing Agility installer to begin the Setup Wizard.
The installer opens and calculates if there is enough space on disk for the installation.
3. Once the Install Wizard confirms that there is enough disk space, click Next.
The End-User License Agreement Setup Wizard step is displayed.
4. Select I accept the terms in the License Agreement and then click Next.
The Prerequisites Setup Wizard step is displayed along with any information about missing
prerequisites.
5. The information displayed on the Prerequisites step is relevant if you are installing the listed
components only.
For example, if you receive a message that the SAP .NET connector is missing, but you are not
using SAP, ignore this message. However, if you are using one of the components listed, click
Cancel and then Finish to exit the Setup Wizard, install the required prerequisite, and then restart
the installer. Otherwise, click Next.
If you did not install the necessary prerequisites, the corresponding options are not available for
installation.
The Choose Setup Type Setup Wizard step is displayed.
6. On the Choose Setup type window, select Full.
The Invoice Processing Agility Client Database Connection Setup Wizard step is displayed.
7. On the Invoice Processing Agility Client Database Connection step, enter the following
information to configure your database connection.
Tip Ensure that the user specified to create this database connection has at least db_owner
permissions.
a. Enter a Database name.
A default database name is provided. If you modify the database name, note the name as it is
needed later in the installation.
b. Enter your database Server name.
c. Select your database Authentication type.
If you select Windows Authentication, this means that Integrated Security is used to connect
to the client database. If you select SQL Server Authentication, Integrated Security is not used
to connect to the client database. If Integrated Security is enabled, some additional manual
steps are required later when setting up the database connection for the Solution Configuration
Manager.
d. If you are using SQL Server Authentication enter a User name and the corresponding User
password.
e. Click Test connection to ensure that your information is correct. If not, repeat the previous
steps and try again.
f. Once your connection test is successful, click Next.
The Kofax TotalAgility Connection Setup Wizard step is displayed.
8. On the Kofax TotalAgility Connection step, enter the following information.
a. If the default Kofax TotalAgility URL that is provided is not correct, update the TotalAgility URL.
For example, http://<Server name>/TotalAgility/.
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b. Select your Authentication type from one of the following options.
• Authentication by username and password.
• Provide Session ID.
This ID is found by navigating to the TotalAgility Designer home page. Select System
Settings > Settings.
• Windows authentication.
Is you are using Authentication by username and password enter a User name and User
password.
If you are using Provide Session ID, enter the Session ID.
If you are using Windows authentication, no further action is required.
c. Click Test connection to ensure that your information is correct. If not, repeat the previous
steps and try again.
d. Once your connection test is successful, click Next.
The Solution Configuration Manager Setup Wizard step is displayed.
9. On the Solution Configuration Manager website window, enter the following information.
Note A default set of values is presented by this step of the installer. If you do not want to use the
default values, enter or select alternative values.
a. Optionally, enter an alternate Web Site.
Important A web site must exist in IIS before it can be added here. All other items are created
dynamically.
b. Optionally, enter a different Virtual Directory.
c. Optionally, enter a different Application Pool.
d. Optionally, select a Pool Identity.
If you select Custom Account, enter a User name, User domain, and the corresponding User
password.
e. Click Next.
The Solution Configuration Manager Database Setup Wizard step is displayed.
10. On the Solution Configuration Manager Database step, enter the following information.
Note A default set of values is presented by this step of the installer. If you do not want to use the
default values, enter or select alternative values.
a. Optionally, enter an alternate Database name.
b. Optionally, enter an alternate Server name.
c. Select your Authentication Type from one of the following.
• Windows Authentication
• SQL Server Authentication
Tip Ensure that the user specified here has at least db_owner permissions.
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d. If you selected SQL Server Authentication, enter a User name and User password.
e. Click Test connection to ensure that your information is correct. If not, repeat the previous
steps and try again.
f. Once your connection is successful, click Next.
The Ready to Install Kofax Invoice Processing Agility 1.1.0 Setup Wizard step is displayed.
11. On the Ready to install Kofax Invoice Processing Agility 1.1.0 step click Install to proceed with
your installation.
Otherwise, click Back to return to previous steps in the Setup Wizard.
A progress indicator shows the progress of the Kofax Invoice Processing Agility installation.
12. Click Finish.
Optionally, select the View Installation Log option. This opens the log file once the installer is
closed.
The installer closes and if selected, the log file opens.
13. Now that you have run the installer, Invoice Processing Agility is installed, but it does not work in your
environment. You must now configure your installation so that it works for your environment.

Custom installation
If you do not want to install all of the components of Invoice Processing Agility at the same time, or on the
same machine, you can choose which components to install.
If you want to install all components, including the Solution Configuration Manager, use the Full installation
instead.
The components and when they are needed is as follows.
The Invoice Processing Agility assemblies
These assemblies must be installed on every server where Kofax TotalAgility is installed. This includes
any servers running Transformation Server.
SAP Assemblies
These assemblies are required if you are using SAP only and are available in the list of features if the
SAP .NET connector is installed. If this connector is not installed, the SAP assemblies are not available for
installation.
These assemblies must be installed on every server where Kofax TotalAgility is installed.
Oracle Assemblies
These assemblies are required if you are using Oracle only and are available in the list of features if the
Oracle Data Provider .NET connector is installed. If this connector is not installed, the Oracle assemblies
are not available for installation.
These assemblies must be installed on every server where Kofax TotalAgility is installed.
MarkView Assemblies
These assemblies are required if you are using MarkView only and are available in the list of features
if the Oracle Data Provider .NET connector is installed. If this connector is not installed, the MarkView
assemblies are not available for installation.
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These assemblies must be installed on every server where Kofax TotalAgility is installed.
The Invoice Processing Agility client database connection
This database is installed once on a Kofax TotalAgility server or a dedicated database server.
Kofax TotalAgility integration
This updates the Kofax TotalAgility variables that are used by Invoice Processing Agility.
Kofax TotalAgility package
This installs the Invoice Processing Agility package for Kofax TotalAgility. This is installed once and
then used by all Kofax TotalAgility servers.
The Solution Configuration Manager
Install the Solution Configuration Manager once for your Kofax TotalAgility environment. This can be on a
Kofax TotalAgility server or a dedicated Web Server.
Here are the most common scenarios for installing Invoice Processing Agility with a list of components
that are required in each scenario.
• On your Kofax TotalAgility development or production environments you can install all of the Invoice
Processing Agility components.
However, if you have a separate database server, you can point to your database server with this
installer. This means the all necessary components for integrating with Kofax TotalAgility are installed,
even if they are not on the same server where the installer is executed.
Also, if you have a separate web server, it is possible to install the Solution Configuration Manager
separately on that server. If you have both a development and a production server, a separate Solution
Configuration Manager installation is required.
• On Kofax TotalAgility additional servers, install the Invoice Processing Agility assemblies only. This
includes any additional assemblies for SAP, Oracle, or MarkView.
• You can install the Solution Configuration Manager only on any server, as long as it is not installed
elsewhere already.
If you are using both a development server and a production server it is necessary that each server
has its own separate Invoice Processing Agility client database and Solution Configuration Manager
installations.
You can install specific Invoice Processing Agility components using the Setup Wizard by following these
steps.
1. Navigate to your extracted files and open the Installer folder.
The contents of the Installer folder are displayed.
2. Double-click on the Kofax Invoice Processing Agility installer to begin the Setup Wizard.
The installer opens and calculates if there is enough space on disk for the installation.
3. Once the Install Wizard confirms that there is enough disk space, click Next.
The End-User License Agreement Setup Wizard step is displayed.
4. Select I accept the terms in the License Agreement and then click Next.
The Prerequisites Setup Wizard step is displayed along with any information about missing
prerequisites.
5. The information displayed on the Prerequisites step is relevant if you are installing the listed
components only.
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For example, if you receive a message that the SAP .NET connector is missing, but you are not
using SAP, ignore this message. However, if you are using one of the components listed, click
Cancel and then Finish to exit the Setup Wizard, install the required prerequisite, and then restart
the installer. Otherwise, click Next.
If you did not install the necessary prerequisites, the corresponding options are not available for
installation.
The Choose Setup Type Setup Wizard step is displayed.
6. Select Custom and then click Next.
The Custom Setup step is displayed along with a list of available components.
7. On the Custom Setup step, a list of features is listed. By default, all of the listed features are
configured for installation. If you do not want to install one or more features, select Entire feature
will be unavailable for each of those features.
Once you select the necessary components, click Next.
Most of the selected components require further configuration. As a result, depending on what you
select, additional Setup Wizard steps are available.
Use the links below to install each of the following features as appropriate for your installation.
• Invoice Processing Agility assemblies
• Invoice Processing Agility client database connection
• Kofax TotalAgility Integration/package
• The Solution Configuration Manager
8. Now that you have run the installer, Invoice Processing Agility is installed, but it does not work in your
environment. You must now configure your installation so that it works for your environment.

Install Invoice Processing Agility assemblies
For the assemblies, no additional configuration is required.
If the necessary prerequisites for SAP or Oracle are installed, their associated client assemblies are
selected automatically. Because of this, it is important to ensure that the desired client assemblies are
installed only.
For example, if you have the Oracle prerequisites installed, this enables the MarkView assemblies
automatically. If you do not want to install the MarkView assemblies, ensure that they are set to Entire
feature will be unavailable.
However, if you are using MarkView, some manual steps are required when the installer is complete.
The following steps assume that you are installing the Invoice Processing Agility assemblies only. If you
do select additional features, refer back to the Custom install for their individual installation instructions.
You can install the Invoice Processing Agility assemblies and any valid client assemblies by following
these steps.
1. On the Custom Setup step, ensure that the required Assembiles are set to Will be installed on
local hard drive and then click Next.
The Ready to install Kofax Invoice Processing Agility 1.1.0 Setup Wizard step is displayed.
2. Click Install.
A progress bar is shown indicating the installation progress of the selected assemblies.
3. Click Finish.
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Optionally, select the View Installation Log option. This opens the log file once the installer is
closed.
The installer closes and if selected, the log file opens.

Install Invoice Processing Agility client database
Install the Invoice Processing Agility client database once on any Kofax TotalAgility server or a dedicated
database server.
The following steps assume that you are installing the Invoice Processing Agility client database only.
If you do select additional features, refer back to the Custom install for their individual installation
instructions.
You can install the Invoice Processing Agility client database by following these steps.
1. On the Custom Setup step, ensure that the Invoice Processing Agility client database is set to Will
be installed on local hard drive and then click Next.
The Invoice Processing Agility client database connection Setup Wizard step is displayed.
2. On the Invoice Processing Agility client database connection step, enter the following
information.
a. Enter a Database name.
A default database name is provided. If you modify the database name, note the name as it is
needed later in the installation.
b. Enter your database Server name.
c. Select your database Authentication type.
If you select Windows Authentication, this means that Integrated Security is used to connect
to the client database. If you select SQL Server Authentication, Integrated Security is not used
to connect to the client database. If Integrated Security is enabled, some additional manual
steps are required later when setting up the database connection for the Solution Configuration
Manager.
d. If you are using SQL Server Authentication enter a User name and the corresponding User
password.
e. Click Test connection to ensure that your information is correct. If not, repeat the previous
steps and try again.
f. Once your connection test is successful, click Next.
The Ready to install Kofax Invoice Processing Agility 1.1.0 Setup Wizard step is displayed.
3. Click Install.
A progress bar is displayed showing the creation or update of the Invoice Processing Agility client
database.
4. Click Finish.
Optionally, select the View Installation Log option. This opens the log file once the installer is
closed.
The installer closes and if selected, the log file opens.
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Kofax TotalAgility integration and package
If you select Kofax TotalAgility Integration, the Kofax TotalAgility Package is selected automatically. You
cannot install one without the other.
The following steps assume that you are installing the Kofax TotalAgility integration and package only.
If you do select additional features, refer back to the Custom install for their individual installation
instructions.
If you are installing the Kofax TotalAgility integration and package only, it is possible to skip the following
steps.
1. Invoice Processing Agility client database connection
2. Solution Configuration Manager
You can skip either or both of these steps if you do not know the Invoice Processing Agility client database
connection or the Solution Configuration Manager configuration settings.
However, if you do skip these steps, it is necessary to manually enter this information at a later time.
Once you know the necessary information, you can either run the installer again or you can manually
enter the necessary information on the Settings page.
You can install the Kofax TotalAgility integration and package by following these steps.
1. On the Custom Setup step, ensure that Kofax TotalAgility Integration and Kofax TotalAgility Package
are set to Will be installed on local hard drive and then click Next.
The Invoice Processing Agility client database connection Setup Wizard step is displayed.
2. On the Invoice Processing Agility Client Database Connection step, enter the following
information to configure your database connection.
Tip Ensure that the user specified to create this database connection has at least db_owner
permissions.
a. Enter a Database name.
A default database name is provided. If you modify the database name, note the name as it is
needed later in the installation.
b. Enter your database Server name.
c. Select your database Authentication type.
If you select Windows Authentication, this means that Integrated Security is used to connect
to the client database. If you select SQL Server Authentication, Integrated Security is not used
to connect to the client database. If Integrated Security is enabled, some additional manual
steps are required later when setting up the database connection for the Solution Configuration
Manager.
d. If you are using SQL Server Authentication enter a User name and the corresponding User
password.
e. Click Test connection to ensure that your information is correct. If not, repeat the previous
steps and try again.
f. Once your connection test is successful, click Next.
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The Kofax TotalAgility Connection Setup Wizard step is displayed.
3. On the Kofax TotalAgility Connection step, enter the following information.
a. If the default Kofax TotalAgility URL that is provided is not correct, update the TotalAgility URL.
For example, http://<Server name>/TotalAgility/.
b. Select your Authentication type from one of the following options.
• Authentication by username and password.
• Provide Session ID.
This ID is found by navigating to the TotalAgility Designer home page. Select System
Settings > Settings.
• Windows authentication.
Is you are using Authentication by username and password enter a User name and User
password.
If you are using Provide Session ID, enter the Session ID.
If you are using Windows authentication, no further action is required.
c. Click Test connection to ensure that your information is correct. If not, repeat the previous
steps and try again.
d. Once your connection test is successful, click Next.
The Solution Configuration Manager Setup Wizard step is displayed.
4. On the Solution Configuration Manager step, enter the Solution Configuration Manager URL
and then click Next.
The Ready to install Kofax Invoice Processing Agility 1.1.0 Setup Wizard step is displayed.
5. Click Install.
A progress bar is displayed showing the creation or update of the Invoice Processing Agility client
database.
6. Click Finish.
Optionally, select the View Installation Log option. This opens the log file once the installer is
closed.
The installer closes and if selected, the log file opens.

Install the Solution Configuration Manager
Install the Solution Configuration Manager once for your Kofax TotalAgility environment. This can be on a
Kofax TotalAgility server or a dedicated Web Server.
If you are using a Microsoft Azure environment, install the Solution Configuration Manager feature only.
The following steps assume that you are installing the Solution Configuration Manager only. If you do
select additional features, refer back to the Custom install for their individual installation instructions.
You can install the Solution Configuration Manager by following these steps.
1. On the Custom Setup step, ensure that the Solution Configuration Manager is set to Will be
installed on local hard drive and then click Next.
The Solution Configuration Manager Setup Wizard step is displayed.
2. On the Solution Configuration Manager website window, enter the following information.
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Note A default set of values is presented by this step of the installer. If you do not want to use the
default values, enter or select alternative values.
a. Optionally, enter an alternate Web Site.
Important A web site must exist in IIS before it can be added here. All other items are created
dynamically.
b. Optionally, enter a different Virtual Directory.
c. Optionally, enter a different Application Pool.
d. Optionally, select a Pool Identity.
If you select Custom Account, enter a User name, User domain, and the corresponding User
password.
e. Click Next.
The Solution Configuration Manager Database Setup Wizard step is displayed.
3. On the Solution Configuration Manager Database step, enter the following information.
Note A default set of values is presented by this step of the installer. If you do not want to use the
default values, enter or select alternative values.
a. Optionally, enter an alternate Database name.
b. Optionally, enter an alternate Server name.
c. Select your Authentication Type from one of the following.
• Windows Authentication
• SQL Server Authentication
Tip Ensure that the user specified here has at least db_owner permissions.
d. If you selected SQL Server Authentication, enter a User name and User password.
e. Click Test connection to ensure that your information is correct. If not, repeat the previous
steps and try again.
f. Once your connection is successful, click Next.
The Ready to Install Kofax Invoice Processing Agility 1.1.0 Setup Wizard step is displayed.
4. Click Install.
A progress bar is displayed showing the creation and configuration of the Solution Configuration
Manager database.
5. Click Finish.
Optionally, select the View Installation Log option. This opens the log file once the installer is
closed.
The installer closes and if selected, the log file opens.
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Command Line installation and parameters
It is possible to use the Command Line to install Invoice Processing Agility. This type of installation
provides you with more control over configuration settings during installation so that you can remotely
deploy the software across the network or onto several machines at once. You can also use the command
line if you want to use a silent installation.
You can use the MSI installer if you want to install the software onto multiple machines over a network,
and do not want to visit each machine individually.
For example, the following command is one of many examples for installing Invoice Processing Agility.
msiexec /i IPAgilitySetup.msi SAP_INSTALLATION_TYPE=0 SCM_INSTALLATION_TYPE=1

If a parameter is not included in the command, its default value is used. In the above command, the basic
assemblies are installed. Since the SAP assemblies are explicitly listed, those too are installed. All other
features with the exception of the Solution Configuration Manager are installed with their default settings.
For more information about the msiexec.exe options, see the Microsoft MSDN description of Command
Line options.
The following parameters are available when installing Invoice Processing Agility.
Command Line Parameters
Parameter

Description and Value Options

BASIC_INSTALLATION_TYPE

This parameter is mandatory and must be included in the installation
command. If this parameter is not included, its default value is applied.
The default value for this parameter is 1.
When this parameter value is set to 1 the basic assemblies required by
Invoice Processing Agility are installed.
When this parameter value is set to 0 the installation of the basic assemblies
and all other assembly types are skipped.
For assemblies, the hierarchy is as follows.
• Basic assemblies
• SAP assemblies
• Oracle assemblies
• MarkView assemblies
This hierarchy means that child assemblies can only be installed when their
parent is installed.
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Parameter

Description and Value Options

SAP_INSTALLATION_TYPE

This parameter is mandatory and must be included in the installation
command. If this parameter is not included, its default value is applied.
The default value for this parameter is 0, but it cannot be installed if the
BASIC_INSTALLATION_TYPE=0. This is because the basic assemblies are
required for the SAP assemblies.
When this parameter value is set to 1 the SAP assemblies required by
Invoice Processing Agility are installed. However, if the prerequisites for SAP
are not installed, this is skipped, even if its value is set to 1.
When this parameter value is set to 0 the installation of the SAP assemblies
is skipped.

ORACLE_INSTALLATION_TYPE

This parameter is mandatory and must be included in the installation
command. If this parameter is not included, its default value is applied.
The default value for this parameter is 0, but it cannot be installed if the
BASIC_INSTALLATION_TYPE=0. This is because the basic assemblies are
required for the Oracle assemblies.
When this parameter value is set to 1 the Oracle assemblies required by
Invoice Processing Agility are installed. However, if the prerequisites for
Oracle are not installed, this is skipped, even if its value is set to 1.
When this parameter value is set to 0 the installation of the Oracle
assemblies is skipped.

MARKVIEW_INSTALLATION_TYPE

This parameter is mandatory and must be included in the installation
command. If this parameter is not included, its default value is applied.
The default value for this parameter is 0, but it cannot be installed
if the BASIC_INSTALLATION_TYPE=0. This is because the basic
assemblies are required for the MarkView assemblies. Similarly, if the
ORACLE_INSTALLATION_TYPE=0, you cannot install the MarkView
assemblies.
When this parameter value is set to 1 the MarkView assemblies required
by Invoice Processing Agility are installed. However, if the prerequisites for
Oracle and MarkView are not installed, this is skipped, even if its value is set
to 1.
When this parameter value is set to 0 the installation of the MarkView
assemblies is skipped.

DATABASE_INSTALLATION_TYPE

This parameter is mandatory and must be included in the installation
command. If this parameter is not included, its default value is applied.
The default value for this parameter is 1.
When this parameter value is set to 1 the Invoice Processing Agility client
database is installed based on several additional SQL parameters.
When this parameter value is set to 0 the installation of the Invoice
Processing Agility client database is skipped.

SQL_SERVER_NAME

This parameter is mandatory if you set
DATABASE_INSTALLATION_TYPE=1.

This is the name of the SQL Server where you want to create the Invoice
Processing Agility client database.
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Parameter

Description and Value Options

SQL_DATABASE_NAME

This parameter is mandatory if you set
DATABASE_INSTALLATION_TYPE=1.

This is the name of the SQL database. By default, this is set to
InvoiceProcessingAgility_Client. Edit the database name if
necessary.
SQL_AUTHENTICATION_TYPE

This parameter is mandatory if you set
DATABASE_INSTALLATION_TYPE=1.

Set this parameter to WINDOWS for Windows Authentication. Alternatively, set
it to SQL_SERVER to use SQL Server authentication.
If you select Windows Authentication, this means that Integrated Security
is used to connect to the client database. If you select SQL Server
Authentication, Integrated Security is not used to connect to the client
database. If Integrated Security is enabled, some additional manual steps
are required later when setting up the database connection for the Solution
Configuration Manager.
SQL_USER_NAME

This parameter is mandatory if you set
SQL_AUTHENTICATION_TYPE=SQL_SERVER.

Set this parameter to the name of the SQL user.
SQL_USER_PASS

This parameter is mandatory if you set
SQL_AUTHENTICATION_TYPE=SQL_SERVER.

Set this parameter to the password of the SQL user.
SKIP_DATABASE_INT

This parameter is required in one specific scenario only. It
is available only if KTA_INT_INSTALLATION_TYPE=1 and
DATABASE_INSTALLATION_TYPE=0. In this case, it is possible to skip
updating the database variable in Kofax TotalAgility if you do not have the
database details to hand. The database configuration can be done at a later
time.

KTA_INT_INSTALLATION_TYPE

This parameter is mandatory and must be included in the installation
command. If this parameter is not included, its default value is applied.
The default value for this parameter is 1.
When this parameter is set to 1 the Kofax TotalAgility variables that are used
by Invoice Processing Agility are updated.
When set to 0, no variables are updated and the Kofax TotalAgility package
is not installed.

KTA_PKG_INSTALLATION_TYPE

This parameter is mandatory and must be included in the installation
command. If this parameter is not included, its default value is applied.
The default value for this parameter is 1.
When this parameter is set to 1 the Invoice Processing Agility package for
Kofax TotalAgility is installed.
When set to 0, the package is not installed.
This is a child of KTA_INT_INSTALLATION_TYPE. This means that you
cannot install the child without installing the parent.

KTA_URL

This parameter is mandatory if you set KTA_INT_INSTALLATION_TYPE=1.
Enter the name of the URL used by Kofax TotalAgility.
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Parameter

Description and Value Options

KTA_LOGIN_TYPE

This parameter is mandatory if you set KTA_INT_INSTALLATION_TYPE=1.
This parameter can be set to the following authentication types.
• WINDOWS for Windows authentication

• USERNAMEANDPASSWORD for Kofax TotalAgility local authentication
• SESSIONID for session-specific authentication
KTA_USERNAME

This parameter is mandatory if you set
KTA_LOGIN_TYPE=USERNAMEANDPASSWORD.
Enter the Kofax TotalAgility user name.

KTA_PASSWORD

This parameter is mandatory if you set
KTA_LOGIN_TYPE=USERNAMEANDPASSWORD.
Enter the Kofax TotalAgility user password.

KTA_SESSIONID

This parameter is mandatory if you set KTA_LOGIN_TYPE=SESSIONID.

SCM_INSTALLATION_TYPE

This parameter is mandatory and must be included in the installation
command. If this parameter is not included, its default value is applied.

Enter the Kofax TotalAgility session id.

The default value for this parameter is 1.
When this parameter is set to 1 the Solution Configuration Manager is
installed based on several additional SCM parameters.
SCM_WEBSITE_NAME

This parameter is mandatory if you set SCM_INSTALLATION_TYPE=1.

SCM_VIRTUAL_DIR_NAME

This parameter is mandatory if you set SCM_INSTALLATION_TYPE=1.

SCM_POOL_NAME

This parameter is mandatory if you set SCM_INSTALLATION_TYPE=1.

SCM_POOL_IDENTITY_TYPE

This parameter is mandatory if you set SCM_INSTALLATION_TYPE=1.

This is the name of the IIS Web Site that you want to use. By default, this is
set to the Default Web Site.
This is the name of the IIS Virtual Directory you want to use. This is set to
IPASCM by default.
This is the name of the IIS Pool name. This is set to SCMAppPool by default.
Choose from one of the following identity types for your application pool.
• LOCALSERVICE
• LOCALSYSTEM

• NETWORKSERVICE

• APPPOOLIDENTITY
• CUSTOMACCOUNT
SCM_POOL_USERNAME

This parameter is mandatory if you set
SCM_POOL_IDENTITY_TYPE=CUSTOMACCOUNT.
Enter the name of the user for the IIS Pool.

SCM_POOL_USERDOMAIN

This parameter is mandatory if you set
SCM_POOL_IDENTITY_TYPE=CUSTOMACCOUNT.
Enter the domain of the user for the IIS Pool.
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Parameter

Description and Value Options

SCM_POOL_USERPASSWORD

This parameter is mandatory if you set
SCM_POOL_IDENTITY_TYPE=CUSTOMACCOUNT.
Enter the password of the user for the IIS Pool.

SCM_SQL_SERVER_NAME

This parameter is mandatory if you set SCM_INSTALLATION_TYPE=1.

SCM_SQL_DATABASE_NAME

This parameter is mandatory if you set SCM_INSTALLATION_TYPE=1.

SCM_SQL_AUTHENTICATION_TYPE

This parameter is mandatory if you set SCM_INSTALLATION_TYPE=1.

SCM_SQL_USER_NAME

This parameter is mandatory if you set
SCM_SQL_AUTHENTICATION_TYPE=SQL_SERVER.

Enter the SQL Server name.

Enter the SQL database name. By default, this is set to IPASCM. Change
this as necessary.
Set this parameter to WINDOWS for Windows Authentication. Alternatively, set
it to SQL_SERVER to use SQL Server authentication.

Set this parameter to the name of the SQL user.
SCM_SQL_USER_PASS

This parameter is mandatory if you set
SCM_SQL_AUTHENTICATION_TYPE=SQL_SERVER.
Set this parameter to the password of the SQL user.

SKIP_SCM_INT

This parameter is required in one specific scenario only. It is available only if
KTA_INT_INSTALLATION_TYPE=1 and SCM_INSTALLATION_TYPE=0. In
that case, it is possible to skip the Solution Configuration Manager URL step
if you do not have the web server details to hand. The Solution Configuration
Manager URL can be entered at a later time.

SCM_URL

This parameter is required in one specific scenario only. It is available only if
KTA_INT_INSTALLATION_TYPE=1 and all other steps are set to 0.
Enter the Solution Configuration Manager URL.

Important Some of the above parameters work in a hierarchy. This means that if your command
explicitly installs a child, but explicitly does not install the parent, neither are installed.
For example, your command includes the following installation type parameters.
BASIC_INSTALLATION_TYPE=0 SAP_INSTALLATION_TYPE=0 ORACLE_INSTALLATION_TYPE=0
MARKVIEW_INSTALLATION_TYPE=1

In this scenario, even though you want to install the MarkView assemblies, nothing is installed. This is
because the MarkView assemblies are a child of the Oracle assemblies, which are also a child of the
basic Invoice Processing Agility assemblies.
If you want to install MarkView assemblies, you need to add the following parameters to your command.
BASIC_INSTALLATION_TYPE=1 SAP_INSTALLATION_TYPE=0 ORACLE_INSTALLATION_TYPE=1
MARKVIEW_INSTALLATION_TYPE=1
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Silent Install
If you do not want to perform an interactive installation of Invoice Processing Agility, you can use a silent
installation. This automatic installation does not display configuration, progress, feature information or
warning messages. It does however, display any error messages.
The following parameters can be added to the command line for a silent installation.
Parameter

Description and Value Options

/? or /h

Displays the help for the command.

/quiet, /q, or /qn

Runs the installer with no user interaction.

l*v [filename]

Writes the installer log messages to the specified file.

/x

Removes the product.

/i

Installs the product.

<property>=<value>

Passes additional parameters to the installer.

You can install Invoice Processing Agility using the silent install by following these steps.
1. Locate the Command Prompt on your computer.
If you are an Administrator, double-click to open the application. If you are not an Administrator, rightclick and select Run as administrator.
The Command Prompt opens.
2. Navigate to where you extracted the ZIP file and the installer.
3. Enter the command to install the features that you need.
For example, use the following command to silently install the base assemblies, the client database,
Kofax TotalAgility integration, and the Kofax TotalAgility package, but not the Solution Configuration
Manager. In addition, a log records the installation steps
msiexec /i IPAgilitySetup.msi /l*v IPAgilitySetupLOG.txt /quiet
SCM_INSTALLATION_TYPE=0

If a feature is excluded from a command, it is assumed that you want to use its
default installation behavior. The default behavior for BASIC_INSTALLATION_TYPE,
DATABASE_INSTALLATION_TYPE, KTA_INT_INSTALLATION_TYPE, and
KTA_PKG_INSTALLATION_TYPE is to install them. This is why these features are not included in the
above command. In addition, the SCM_INSTALLATION_TYPE default is also to install this feature. In
this command however, we override the default value by including it in the command and explicitly
saying not to install the Solution Configuration Manager.
See the command line parameters for more information about default behavior and possible
4. Now that you have run the installer, Invoice Processing Agility is installed, but it does not work in your
environment. You must now configure your installation so that it works for your environment.
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On-premise installation for Invoice Processing Agility hosted on
Microsoft Azure
After Kofax provides your credentials to log on to Invoice Processing Agility in the cloud, it is necessary to
install additional on premise-components to use Invoice Processing Agility.
The following components are required.
1. Install the Kofax TotalAgility Integration Server.
For more information, see the Kofax TotalAgility Integration Server Installation Guide.
2. Extract the KofaxInvoiceProcessingAgilty-1.1.0.zip file.
3. Install the Solution Configuration Manager by excluding all other features on the installer.
For more information, see Install the Solution Configuration Manager
4. Once installed, configure the Solution Configuration Manager.
For more information, see Configure the Solution Configuration Manager .
5. Install or configure your ERP connector.
For more information, see Enterprise Resource Planning system connectors
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Configure Invoice Processing Agility
After installing Invoice Processing Agility, it is necessary to make some configuration changes to Kofax
TotalAgility depending on your needs.
The following steps are for the configuration of Invoice Processing Agility. Each step contains its own set
of instructions and the order is important. Skipping steps that are not optional, or performing steps out of
sequence can result in a failed installation.
1. Update the default style sheet used by Kofax TotalAgility.
2. Configure resource access.
3. Optionally, if you are using Windows Authentication, configure the authentication type and timeout
session behavior.
4. Create CSV files for required database lookups.
5. Update references to the CSV databases in the Transformation Designer.
6. Optionally, modify the recognition engines in theTransformation Designer.
This step is necessary only if you are processing documents in languages other than English.
7. Optionally, configure your MarkView settings.
8. Prepare ingestion.
• Configure filesystem ingestion.
• Configure scan ingestion.
• Configure email ingestion.
9. Configure page image renditions.
10. Optionally, install PIX.
11. Restart services.

Update the Kofax TotalAgility theme form style sheet
By default, Kofax TotalAgility uses a style theme that does not display the Validation and the Line Pairing
Correction forms in an ideal manner. As a result, it is recommended that you change the Theme and Style
Sheet in Kofax TotalAgility to use previous versions that work well with the Invoice Processing Agility
forms.
If you do not make these changes your forms are displayed out of alignment, and they are hard to read.
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You can update the theme and style sheet used by the forms in Kofax TotalAgility by following these steps.
1. Logon to the TotalAgility Designer.
2. On the Home page, click Form Designer.
The Form Designer page is displayed.
3. On the Form Designer page, from the left pane, click Themes.
A list of Themes for the Default Category are displayed, if any exist.
4. On the left Themes pane, select TotalAgility Forms from the list.
A list of existing Themes is displayed.
5. Select TotalAgility Workspace.
The theme for the TotalAgility Workspace is displayed.
6. On the main pane, select Classic from the Desktop Style list.
7. On the left pane, select Style Sheets.
A list of style sheets are displayed for the Default Category if any exist.
8. Select TotalAgility Forms from the category list.
A list of style sheets are displayed for the TotalAgility Forms category.
9. Drag the WorkspaceTheme.css style sheet from the left pane to the Style Sheet field in the main
pane.
The Style Sheet is updated.
10. Click Save.
The default theme is saved and all forms are now displayed with the supported style.

Configure Windows authentication and session timeout behavior
By default, Invoice Processing Agility is configured so that it does not use Windows Authentication.
If you want to use Windows authentication, you can modify how Invoice Processing Agility works within
Kofax TotalAgility so that is uses Windows Authentication. If you do make this authentication change you
must also configure the session timeout behavior.
Note If you are using Invoice Processing Agility in an Azure environment you cannot use Windows
authentication.
You can configure Invoice Processing Agility to use Windows Authentication and update its session
timeout behavior by following these steps.
1. Logon to the TotalAgility Designer.
2. On the Home page, click Form Designer.
The Form Designer page is displayed.
3. In the Explorer pane, select Sites.
The Explorer pane is replaced with the Sites pane.
4. From the Category list, select InvoiceProcessingAgility.
A list of available categories is displayed.
5. Click on the icon to the left of IPA and click Open.
The Site configuration page is displayed.
6. In the left Consume pane, select Form.
7. From the list, select InvoiceProcessingAgility.
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A list of available forms is displayed.
8. Drag the Workspage_Logon_Windows_Authentication form to the Default Form option in the
Desktop Settings group.
If you are using the Tablet Settings or the Phone Settings, make this change there too.
9. Click Save in the upper left corner.
The Form Designer page is displayed once more.
10. In the left Sites pane, click < Sites.
The Explorer pane is displayed.
11. From the Explorer pane click Forms.
A list of forms for the selected InvoiceProcessingAgility category is displayed.
12. Select the IPA_SessionTimeout form.
When prompted to lock the form, click Yes.
The existing session timeout form is displayed.
13. To make changes to this form, select Actions from the lower toolbar at the top of the screen.
A list of actions is displayed.
14. Select Redirect1.
The redirect form is displayed.
15. In the Target field enter the following.
./ipa/Workspace_Logon_Windows_Authentication.form
16. Click Release.
Your changes are saved and the form is updated.
17. Click Close and then return to the Home page.
18. Optionally, close the TotalAgility Designer.

Configure resource access
You need to configure resource access in the TotalAgility Designer, so that users can access the Solution
Configuration Manager website. You can configure the resource access by following these steps.
1. Login to the TotalAgility Designer.
2. On the Home page, click Resources.
3. Under Explorer on the left pane, click Resources.
4. Select the InvoiceProcessingAgility category from the menu.
A list of groups is displayed.
5. Click the Group button ( ) to the left of the IPA_Administrators group.
If you click on the IPA_Administrators link instead of the button, you do not have access to the
Open option mentioned below.
Two options for the group are now available.
6. Click Open.
The Group page appears with details of the IPA_Administrators group.
7. On the main pane, click the Resource button ( ) next to the large Members box.
A list of Kofax TotalAgility users is displayed on the left pane.
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8. Drag one or more users from the left pane to the Members box.
9. When you are done adding users, click Save at the top.
10. Once users are set up for IPA_Administrators group, repeat steps 5 - 8 for the other groups in the
InvoiceProcessingAgility category except the Everyone group.
11. Optionally, close the TotalAgility Designer.

User access permissions
You can set access permissions at the group level so that you can better control access without having to
configure access permissions per user.
By default, Invoice Processing Agility has two Resource Groups. This includes:
• IPAResourceGroup_Scan
• IPAResourceGroup_ValidationResources
The IPAResourceGroup_Scan corresponds to the Scan Resource option from the Solution
Configuration Manager > Global Settings > User Management.
Similarly, the IPAResourceGroup_ValidationResources corresponds to the Validation Resource,
LPR Correction Resource, and PIX Correction Resource options from the Solution Configuration
Manager > Global Settings > User Management.
When a User ID is added to the Solution Configuration Manager > Global Settings > User
Management, and the Scan Resource option is selected, the user automatically is assigned the same
permissions as that Resource Group.
However, even though these Resource Groups are available automatically, no Access Permissions
via Kofax TotalAgility are configured when first installed. Because of this, manual Access Permission
configuration is required.
Note As you add new Resource Groups, specific access permissions for that group are required.
Example: User Authorization Example
The following example shows three users and how they are distributed between client groups and
resource groups.
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Resource Group permissions
The IPA_Administrators resource group requires that the following permissions are enabled in the
TotalAgility Designer.
• Read/Write access for Resource
• Read/Write access for CaptureDesign
• Read/Write access for MaintainServer
A member of the IPAResourceGroup_Scan resource group only, requires the following permissions in
the TotalAgility Designer.
• Reject documents
• Delete documents
• Split documents
• Merge documents
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• Rotate pages
A member of the IPAResourceGroup_ValidationResources resource group only, requires the
following permissions in the TotalAgility Designer.
• Reject documents
• Modify/Read documents
• All other batch-editing operations
If a user is a member of both the IPAResourceGroup_Scan resource group and the
IPAResourceGroup_ValidationResources resource group, they require the following permissions in
the TotalAgility Designer.
• Reject documents
• Delete documents
• Split documents
• Merge documents
• Rotate pages
• Modify/Read documents
• All other batch-editing operations

Manage resource groups via Kofax TotalAgility
When Invoice Processing Agility is first installed, there are two main Resource Groups. These groups
however, have no permissions assigned by default. As a minimum, specific permissions are required for
the various resource groups.
Note If you are using Invoice Processing Agility in an Azure environment adding users manually is the
only method available. This is because Solution Configuration Manager > Global Settings > User
Management is not available in this type of environment.
You can configure manual access permissions by following these steps.
1. Launch the TotalAgility Designer.
2. Select System Settings.
The Manage page is displayed.
3. From the Access Permissions group, select Capture.
The Access Permissions - Capture page is displayed.
4. From the Consume panel, click Resources.
A list of all resources configured in Kofax TotalAgility are displayed.
5. From the Resources list, select InvoiceProcessingAgility.
The list of resources is filtered to include only those related to Invoice Processing Agility.
6. From the Resources panel, drag-and-drop a resource group into the Resource field.
The list of settings and users is displayed.
7. Update the various permissions based on requirements.
8. Click Save.
9. Optionally, repeat steps 6 to 8 for additional resource groups.
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Configure the Solution Configuration Manager
You can configure the Solution Configuration Manager by following these steps.
1. Log on to the Invoice Processing Agility Workspace.
For example, http://<ServerName>/TotalAgility/forms/ipa/.
Note If you are using an Azure environment, log on to the Azure workspace instead.
The workspace for Invoice Processing Agility is loaded.
2. In the Workspace menu, select IP Agility > Settings.
The Settings page is loaded.
3. Click Launch SCM.
The Solution Configuration Manager opens and you can now manage its database connection.

Manage database connections
Now that you can open the Solution Configuration Manager, further configuration steps may be required
so that the Invoice Processing Agility client database is configurable via the Solution Configuration
Manager. This depends on the Authentication type selected for the Invoice Processing Agility client
database during install, or if you are using Invoice Processing Agility in an Azure environment.
Important This step is not necessary if you are using Invoice Processing Agility in an Azure
environment.
If you used SQL Server Authentication when installing the Invoice Processing Agility client database then
no changes are required because the database connection is added automatically. Proceed by adding the
Solution Configuration Manager package.
If you used Windows Authentication when installing the Invoice Processing Agility client database then
some manual changes are needed to add a connection to the Invoice Processing Agility client database.
You can manage database connections by following these steps.
1. In the Solution Configuration Manager, hover over the Manage Project Configuration menu and
select Manage Database Connections.
The Manage Database Connection Settings screen is displayed.
2. Enter a value of 1 into the Connection Number field.
3. In the Server Name field, enter the name of the server where the Invoice Processing Agility client
database is installed.
4. In the Database Name field, enter the name of the Invoice Processing Agility client database.
The installer uses InvoiceProcessingAgility_Client. If you made no changes during the
installation use this name.
5. Optionally, enter a User Name and a corresponding Password.
A User Name and Password are necessary only if SQL Authentication was used during installation.
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Note If you are using Windows Authentication to connect to the client database, ensure that the
Integrated Security option is selected.
6. Click Test Connection.
If the connection is not successful, review and edit the settings and try again.
7. When the connection is successful, click Insert.
A confirmation message is displayed when the settings are successfully saved.
8. Click Close to close the confirmation window.
9. Continue to configure the Solution Configuration Manager by adding the Solution Configuration
Manager package.

Add the Solution Configuration Manager package
Unlike the Invoice Processing Agility package that was installed in Kofax TotalAgility, the Solution
Configuration Manager package is installed from the Solution Configuration Manager website. You can
install the Solution Configuration Manager package by following these steps.
1. Hover over the Manage Project Configuration menu and click Manage Existing Package.
The Manage Package screen is displayed.
2. From the Add new package group, click Browse to choose a file next to the Select File field.
3. Navigate to the extracted zip files and then select the SCM_Install\SCM_IPA1.1.0 zip file.
The selected file is listed in the Select File field.
4. Ensure that the Is Active? check box is selected.
5. Click Add New Package.
A confirmation message is displayed.
6. In the confirmation message window, click Close.
The confirmation message window closes and the package is listed under Existing Packages.
7. Continue by managing the project configuration.

Manage project configuration
Now that you have mapped the client database and installed the Solution Configuration Manager
package, it is necessary to configure the Solution Configuration Manager package.
You can install and configure the Solution Configuration Manager package by following these steps.
1. Click Manage Project Configuration.
The Manage Project Configuration screen is displayed.
2. In the Project Name field, type a project name.
For example, "IPA" or similar.
3.
4.
5.
6.
7.

From the Package list, select the name of the package.
From the Version list, select the version number.
From the Connection Group list, select the connection group.
Ensure that the Active check box is selected.
Click Insert.
A confirmation message is displayed.

36

Kofax Invoice Processing Agility Installation Guide

8. In the confirmation message window, click Close.
The confirmation message window closes and the Solution Configuration Manager is now ready for
use.

CSV files for database lookups
Before you can use Invoice Processing Agility in production it is necessary to create the CSV files that are
used by the database lookups that appear in Validation. This is because the Associative Search Engine
used by these database lookups requires a CSV file.
To aid in this, there is an automatic process to convert the BRWVendorMaster, BRWEmployeeMaster,
and BRWCompanyAddressMaster tables from the Invoice Processing Agility client database into CSV
format. These CSV files are then stored in Kofax TotalAgility and used by the database lookups.
By default, the following three databases exist in Transformation Designer and they directly correlate to
the Invoice Processing Agility client master database tables.
• VendorASE
• EmployeeASE
• CompanyCodeASE
However, there is no information available for these databases until you create CSV files based on your
Vendor, Employee, and Company Code data.
If you are not using the Employee field, the BRWEmployeeMaster table is not needed. Similarly, if you
are getting the Company Code from the PO or from the file name, the BRWCompanyAddressMaster
table is not needed. You can leave one or both of these tables blank.
The BRWVendorMaster is always used and needs populated with your own data.
If you do not have any vendor, employee, or company code data, you can still create the CSV files. This is
because mock data is provided for empty tables to ensure that the CSV creation succeeds. You can add
your own data to one or more of the master database tables at a later time.
In order to ensure that the database lookups behave as intended, do the following.
1. Optionally, add your own data to the master tables that you are using.
2. Create the CSV files.
3. Configure your CSV files to regularly update.
4. If you did not add data to the master tables earlier, add your data now.
The CSV files are updated automatically the next time that your schedule job is executed.
Alternatively, you can force the CSV file to update by running the same job you used to create the
CSV files in the first place.
For more information on Transformation Designer and how to use this tool, please refer to the
Transformation Designer Help.
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Vendor master database
Use the following table to prepare your Vendor Master data for export into the BRWVendorMaster
database.
Note This table is mandatory. Populate it with your own data to ensure that the database locator is able
to reconcile your vendors during Validation.
Column

Type

Description

Example

IndexID

varchar

A unique key for vendor addresses across all
partitions. This IndexID is a compound string
that is made up from the PartitionID, the ID
(Vendor), and if available, the SiteID.

0-12345~5

The PartitionID and the ID are separated by
a hyphen (-). By default, the ID and SiteID are
separated by a tilde (~).

In the above example,
the PartitionID is
0, the ID (Vendor) is
12345, and the SiteID
is 5.

This separator between the ID and the SiteID
is configurable under Solution Configuration
Manager > Profile Settings > Vendor Settings >
"Alpha Num Site Separator."
PartitionID

int

The Vendor partition. This is used to distinguish
Vendors from different sources.

0

ID

varchar

The Vendor ID that is used in the ERP.

12345

SiteID

varchar

The SiteID for the associated Vendor. This may
not be used for some Vendors.

5

If this is used, it is part of the IndexID.
Note The SiteID is commonly used by
Oracle or PeopleSoft.
Name

varchar

Vendor name.

Thumps Up

Address1

varchar

First line of Vendor address.

Drummers Lane

Address2

varchar

Second line of Vendor address, if applicable.

City

varchar

City of the Vendor address.

Houston

Zip

varchar

Post code or Zip code of the Vendor address.

77032

State

varchar

State or region of the Vendor address.

TX

Country

varchar

Country of the Vendor address.

US

POBox

varchar

PO Box of the Vendor Address, if applicable.

12345678

POBoxZip

varchar

PO Box Zip code of the Vendor Address, if
applicable.

77032

This must be given as an ISO 3166 Alpha-2
character code.
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Column

Type

Description

Example

EUMember

varchar

Indicates whether or not the Vendor is from a
country that is a member of the European Union.

X

Use an "X" to indicate that a Vendor is from an EU
country.
When a Vendor is from an EU country, this column
indicates when it is necessary to resolve tax codes
and provide VAT compliancy checks.
Currency

varchar

TAXID1

varchar

TAXID2

varchar

VATRegNo

varchar

Currency of the Vendor Country.
The currency code must comply with the ISO 4437
code standard.

GBP

The Primary Tax ID for a Vendor.
Invoice Processing Agility does not require this for
any business logic. However, you can populate
and use this as a searchable field if needed.
The Secondary Tax ID for a Vendor.
Invoice Processing Agility does not require this for
any business logic. However, you can populate
and use this as a searchable field if needed.
The Vendor VAT registration number(s).
Multiple VAT registration numbers must be
presented as a comma-separated list, if the
Vendor is VAT registered in more than one
country.

DE118827839

VAT registration numbers should contain the twocharacter country prefix, but this is not mandatory.
This is used to populate the VendorVATRegNo
field if a VAT compliancy check is required.
TaxJurCode

varchar

TelNo

varchar

InvoiceType

varchar

The tax jurisdiction code.
Invoice Processing Agility does not require this for
any business logic. However, you can populate
this field and access it in custom user exits.
The Vendor telephone number.
Invoice Processing Agility does not require this for
any business logic. However, you can populate
and use this as a searchable field if needed.
The Vendor invoice type.
This must correspond to the configured PO or NPO
value specified in the Solution Configuration
Manager > Profile Settings > Invoice Type
Settings.

PO

This is relevant only if theSolution Configuration
Manager > Profile Settings > Invoice Type
Settings > "Set By Vendor" value is set.
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Column

Type

Description

Example

PaymentMethods

varchar

A comma-separated list of Bank methods for the
Vendor.

B,T

This must match one of the methods configured in
the Solution Configuration Manager > Profile
Settings > Payment Method Settings in order to
enable bank account extraction.
BankDetails

varchar

The bank account details for the Vendor.
This is a colon-separated list that uses the
following format.
BankAccount,SortCode,
ERPBankAccountCode:
Note A sort code is the US equivalent of a
routing number.

WithholdingTax
Details

varchar

357357,,CAD1:
789789,,EUR1

In the above example,
the Vendor has two
different sets of
bank details. One for
Canadian dollars, and
another for Euros. In
both cases, the Vendor
does not have a sort
code.

A colon-separated list in the following format.
CompanyCode,WithholdingTaxType,
WithholdingTaxCode:

If there is withholding tax on the invoice at the time
of posting, the system posts the full withholding
tax amount to the entry with the relevant company
code.
Important This column is relevant for SAP
only.
CompanyCodes

varchar

A comma-separated list of company codes that
are valid for the Vendor.
Invoice Processing Agility does not require this for
any business logic. However, you can populate
this field and access it in custom user exits.

UtilityFlag

varchar

PORSubscruberNo

varchar

Indicates if a Vendor is a utility vendor.
If used, this value for this must correspond to one
of the utility aliases configured in the Solution
Configuration Manager > Profile Settings >
Invoice Number Settings.
The Swiss purchase order subscriber number for
the Vendor.
If this value is populated, it overrides the extracted
value during export.

ExternalVendorID

varchar

The external VendorID.
If a Vendor has a value for this field, it is used as
the ID (Vendor).
This is used by some ERP systems like Oracle
EBS.
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Column

Type

Description

ExternalSiteID

varchar

The external SiteID.

Example

Invoice Processing Agility does not require this for
any business logic. However, you can populate
this field and access it in custom user exits.

VendorAccountGroup varchar

The Vendor account group. This is available for
export.

AlternatePayee

varchar

The Vendor alternate payee.

PermittedPayee

varchar

This is used for the ALTERNATIVEPAYYEE
export key if the AlternativePayee field is not
populated.
12345

A comma-separated list of permitted alternative
payees for this Vendor. This list contains the
ID (Vendor) (without the PartitionID and
SiteID).
Important This is supported by SAP only.

SiretID

varchar

The French SiretID for this Vendor, if applicable.

RC NANTES 234 987
456

VendorIdentifier

varchar

A unique Vendor identifier, such as a Chinese tax
registration number.
This is used for vendor scoring if found on the
document.

InterCompany

bit

Indicates if a Vendor is an intercompany vendor.
Intercompany vendors are used only for vendor
extraction if the invoice is classified into the
Intercompany class.

Employee master database
Use the following table to prepare your Employee Master data for export into the BRWEmployeeMaster
database.
Note If you are using the Employee field, populate this table with your own data to ensure that the
database locator is able to reconcile your employees during Validation. If you are not using the
Employee field, leave this table blank.
Column

Type

Description

Example

IndexID

varchar

A unique key for employee addresses
across all partitions. This IndexID is a
compound string that is made up from the
PartitionID and the ID (Employee).

0-12345

The PartitionID and the ID are
separated by a hyphen (-).
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Column

Type

Description

Example

PartitionID

int

The Employee partition. This is used
to distinguish Employees from different
sources.

0

ID

varchar

The Employee ID that is used in the ERP.

12345

Name

varchar

The Employee name.

Michael Miller

Address1

varchar

The first line of the Employee address.

Drummers Lane

Address2

varchar

The second line of the Employee address.

City

varchar

The Employee city.

Houston

Zip

varchar

The Employee post code or zip code.

77032

State

varchar

The Employee state or region.

TX

Country

varchar

The Employee country.

US

TelNo

varchar

The Employee telephone number.

TaxID1

varchar

The Employee primary tax code.

TaxID2

varchar

The Employee secondary tax code.

This must be given as an ISO 3166
Alpha-2 character code.

Company Code database
Use the following table to prepare your Company Code data for export into the
BRWCompanyAddressMaster database.
Note If you are getting the company code from this database table, populate it with your own data to
ensure that the database locator is able to reconcile your company code during Validation. If you are
getting the company code from the PO or the file name, leave this table blank.
Column

Type

Description

CompanyCode

varchar

A unique identifier for a company.

CompanyName

varchar

The name of a company.

CompanyAddress

varchar

The Company address. This address
should be similar to what is printed
on the invoice.

Dump address data to CSV databases
There is a process within Kofax TotalAgility that lets you automatically create CSV files from the
BRWVendorMaster, BRWEmployeeMaster, and BRWCompanyAddressMaster tables in the Invoice
Processing Agility client database. These files are then stored in Kofax TotalAgility.
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You can create the CSV databases needed for the database lookups in Transformation Designer by
following these steps.
1. Ensure that data is available in the Invoice Processing Agility client database for the following tables
if needed.
If you have no data for these database tables at this time, or you do not use all three database
lookups, you can leave the tables blank. The CSV tables are created using mock data that you can
update at a later time as needed.
• BRWVendorMaster
• BRWEmployeeMaster
2.
3.
4.
5.
6.

• BRWCompanyAddressMaster
Open the Invoice Processing Agility Workspace.
From the Jobs menu, select Create.
The Jobs - Create page is displayed.
From the Category list, select InvoiceProcessingAgility.
The Process list is populated with processes.
From the Process list, select DumpAddressFiles.
Click Create.
A message is displayed when the job is created successfully and the Vendor.csv, Employee.csv, and
CompanyCode.csv files are created automatically. These files are stored in Kofax TotalAgility and
picked up automatically by the corresponding Database Locators in Transformation Designer.
However, it is still necessary to Release your project Transformation Designer after you have created
the CSV databases.

Release project with new database references
When Invoice Processing Agility is installed, three Database Lookups are created automatically in
Transformation Designer. Now that you have dumped your address data to CSV files that are stored in
Kofax TotalAgility, it is necessary to open and then release your project in Transformation Designer so that
the newly created databases are used.
You can update the project and its databases by following these steps.
1. Dump your address data.
2. Open the Transformation Designer.
3. From the Project tab, click Open Project.
The Open Project window is displayed.
4. From the Select category group, select the InvoiceProcessingAgility category.
The Select project area is updated.
5. In the Select project area, expand Shared and then double-click on the InvoiceProcessingAgility
project.
The project opens.
6. On the Project tab, click Project Settings.
The Project Settings window opens.
7. In the Project Settings window, click on the Databases tab.
The Databases tab is displayed.
8. Select the VendorASE database and click Import.
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When prompted to import the database click Yes.
The corresponding CSV file is imported.
9. Select the EmployeeASE database and click Import.
When prompted to import the database click Yes.
The corresponding CSV file is imported.
10. Select the CompanyCodeASE database and click Import.
When prompted to import the database click Yes.
The corresponding CSV file is imported.
11. On the Project Settings window click OK.
Your changes are saved and the window closes.
12. On the Project tab, click Release.
The project is released.
13. Close the Transformation Designer.

Configure the CSV databases to update automatically
When you converted the BRWVendorMaster, BRWEmployeeMaster, and
BRWCompanyAddressMaster tables into CSV databases, that was a single point-in-time representation
of that data. Since it is likely that some of these tables are modified regularly with additional data over the
lifetime of your project, it is necessary to update the CSV files at regular intervals.
You can update the CSV databases at regular intervals by following these steps.
1. Launch the TotalAgility Designer.
2. Optionally, log in with your Kofax TotalAgility Administrator user credentials if prompted.
3. On the Home page, click System Settings.
The System Settings page is displayed.
4. On the System Settings page, click Job Schedules.
A list of scheduled jobs is displayed for the default category.
5. From the Categories list, select InvoiceProcessingAgility.
A list of scheduled jobs is displayed for Invoice Processing Agility.
6. Double-click on the AddressData2CSV scheduled job.
7. When prompted, click Yes to lock the scheduled job for modification.
The properties for the job are displayed.
8. For the Active option, set it to Yes.
9. Edit the Frequency and Range of Recurrence settings as necessary.
For more information on these settings, see the Kofax TotalAgility Help.
10. In the upper right corner, click OK so save your settings.
You are returned to the list of scheduled jobs and your CSV files are now updated at regular
intervals.
11. Close the TotalAgility Designer.
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Integrate MarkView with Invoice Processing Agility
This integration is necessary only if you are using MarkView and want to integrate it with Invoice
Processing Agility. In addition, if you are using MarkView, please ensure that the Oracle Client Component
is installed. If this client is available, the MarkView option is installed automatically with the Invoice
Processing Agility Full installation. If you use the Custom installation, MarkView is available for selection.
If you use the silent install method, add the MARKVIEW_INSTALLATION_TYPE=1 parameter to your
command.
Important If you are using MarkView, there is no functionality within MarkView to differentiate the vendor
type. If you have invoices that include Intercompany vendors, create your own method of identifying
which vendors are Intercompany vendors. For more information on Intercompany invoices, see the
Invoice Processing Agility Administrator's Guide.
After the MarkView components are installed, follow these steps to configure Invoice Processing Agility.
1. Update the Invoice Processing Agility client database for MarkView.
2. Configure the MarkView database connection within Invoice Processing Agility.
3. Configure your MarkView export settings.

Update the Invoice Processing Agility client database for MarkView
If you are using MarkView and want to integrate it with Invoice Processing Agility, you must update the
Invoice Processing Agility client database so that it is compatible with MarkView.
You can update the Invoice Processing Agility client database so that it works with MarkView by following
these steps.
1. Open the Microsoft SQL Server Management Studio.
2. Navigate to your extracted files and open Database_Scripts/Update.
3. Drag the UpdateMarkview.sql file into Microsoft SQL Server Management Studio.
The script is loaded.
4. Edit the script with the following changes.
a. Edit the value for the @profileID.
The value for this should match the Profile ID in Invoice Processing Agility that is processing
documents with MarkView.
b. Edit the value for @sqlConnectionGroup.
The value for this should be the connection group related to the MarkView database connection
string that is configured in the Solution Configuration Manager > Global Settings >
Database Connection Settings.
5. Ensure that the Invoice Processing Agility client database is selected and then press Execute.
The query is performed and the Invoice Processing Agility client database is updated to work with
MarkView.
6. Since several fields are activated by executing this script, it is necessary to update the Document
Variants.
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For more information on document variants, see the Invoice Processing Agility Administrator's Guide.
a. Open the Solution Configuration Manager.
b. Select a Project from the list.
An additional Settings list is displayed.
c. From the Settings list, select Profile Settings.
An additional Profile list and two buttons are displayed.
d. Click Update Document Variants
The document variants for all profiles are updated.
7. Optionally, Close the Solution Configuration Manager.

Configure MarkView database connection
In order for Invoice Processing Agility to successfully interact with MarkView, a connection string for the
MarkView database is required in the Solution Configuration Manager. This connection string is then used
to access the MarkView database as well as the integration between MarkView and the main Invoice
Processing Agility client database.
This database is also used to synchronize vendors from, export documents to, and perform purchase
order lookups in MarkView.
For more information about MarkView integrations, see the Invoice Processing Agility Administrator's
Guide.
You can configure the MarkView database connection by following these steps.
1. Open the Solution Configuration Manager.
2. Navigate to the Solution Configuration Manager > Global Settings > Database Connection
Settings.
3. Add a Connection Group ID.
This ID is usually the next number in the sequence.
4. Enter a Connection String for your MarkView database.
5. Click Insert.
The connection string is added to your database settings.

Configure MarkView export settings
Once you have updated the Invoice Processing Agility client database to work with MarkView, it is
important to configure the export settings so that they work for MarkView. For more information on these
export settings, see the Invoice Processing Agility Administrator's Guide.
You can edit the MarkView export settings by following these steps.
1. Open the Solution Configuration Manager.
2. Navigate to the Solution Configuration Manager > Export Settings > Export Options.
3. Select Export to MarkView.
Additional options are available.
4. Select the Markview Connection Group.
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This is configured in Solution Configuration Manager > Global Settings > Database Connection
Settings.
5. Enter the MarkView Import API Username.
This is the unique username used to log on to MarkView.
6. Enter the MarkView Import API Password.
This is the associated password to the above username.
Note As you type in this password, the individual characters are displayed as expected. However,
when you click Save, the password is encrypted and saved in a dedicated password file. In the
field, the regular characters are replaced with the encrypted value from the password file.
7. Click Save.
Your export changes are saved.

Integrate AP Agility with Invoice Processing Agility
If you are using AP Agility as well as Invoice Processing Agility, it is necessary to make a few changes
to the Invoice Processing Agility client database. These changes are needed so that you can effectively
import, export, and configure AP Agility.
However, it is possible to integrate with an ERP system without installing AP Agility. In this use case, the
Invoice Processing Agility client database also needs updated with the same scripts used when AP Agility
is installed.
Note Integration with AP Agility, whether it is installed or not, is available in an on-premise environment
only.
You can update the Invoice Processing Agility client database so that it works with AP Agility by following
these steps.
1. Open the Microsoft SQL Server Management Studio.
2. Navigate to your extracted Invoice Processing Agility files and open Database_Scripts/Update.
3. Drag the UpdateAPAgility.sql into Microsoft SQL Server Management Studio.
The script is loaded.
4. Ensure that the Invoice Processing Agility client database is selected and then press Execute.
The query is performed and the Invoice Processing Agility client database is updated with the
necessary AP Agility tables.
This means that if AP Agility is installed, it can successfully work with Invoice Processing Agility.
If AP Agility is not installed, the client database still contains the necessary tables needed to
configure an ERP connector.
5. Close the Microsoft SQL Server Management Studio.
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Create document variants
When Invoice Processing Agility is first installed, there is a default client and associated profile. There is
not however, a document variant for this profile.
Since a document variant is required to determine which fields are displayed during validation, it is
necessary to create a document variant.
Even though document variants are part of Kofax TotalAgility, do not edit them in the TotalAgility Designer.
Instead, an automatic mapping is in place so any changes made to the Solution Configuration Manager
> Profile Settings > Field Settings for a specific profile are automatically updated in the corresponding
document variants.
If you are happy with the fields that are active by default for your profiles, you can create document
variants for all profiles at once by clicking on the Update Document Variants button. This button is
available whenever you select Profile Settings in the Solution Configuration Manager. Otherwise, you
can create a document variant for a profile by following these steps.
1. Open the Solution Configuration Manager.
2. From the Settings list, select Profile Settings.
A list of available profiles is displayed.
3. Select a Profile from the list.
A list of profile-specific settings is displayed.
4. From the list of settings, select Field Settings.
After a few moments, a list of fields is displayed for the selected profile.
5. For each field listed, select or clear the Active option.
Selected/Active fields are extracted and displayed in Validation. Cleared/Deactivated fields are not
displayed in Validation.
6. Click Save.
If you activated fields for both the Invoices and the InvoicesCN classes, a document variant is
created for each class in Kofax TotalAgility, specific to the selected profile. If you activate fields for
the Invoices class and deactivate the InvoicesCN fields, a single document variant is created for the
Invoices class only.
Note If you need the InvoicesCN class, ensure that the necessary fields are active. If no fields
are active, the corresponding fields are not available during Validation, as no document variant is
available.
7. Optionally, select a different profile and repeat the above steps to create document variants for
additional profiles.
8. Close the Solution Configuration Manager.
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Modify the Transformation Designer recognition engines
If you are processing documents in languages other than English, it is recommended that you update the
recognition engines in the Transformation Designer. This ensures that the recognition engines are more
efficient for your needs than they are by default.
You can modify the recognition engines by following these steps.
1. On the Project Settings window and click the Recognition tab.
A list of recognition engines is displayed.
2. Double-click on the default FineReader recognition Engine. This is the third entry in the list.
The FineReader Profile Settings window is displayed.
3. In the Languages list, select each language that you process.
Tip For the best results, leave Digits and English selected.
4. Click OK to save your changes.
The FineReader - Profile Settings window is closed.
5. Click OK to save changes to the project settings.
The Project Settings window is closed.
6. In the Project tab, click Release Project.
7. Close the Transformation Designer.

Prepare ingestion configuration
Before you can configure individual types of ingestion, you first need to create a general Invoice
Processing Agility import connection. Once the import connection is available, you can add filesystem
ingestion and email ingestion.
Note If you are using Invoice Processing Agility in an Azure environment, use the Kofax TotalAgility
Integration Server to configure ingestion.
You can add an import connection by following these steps..
1. Open the TotalAgility Designer.
2. On the Home page, click Integration.
The Manage page is displayed.
3. On the Integration page, click Import Settings.
The Import Settings page is displayed, but there are no Import Connections configured.
4. Click
next to Import Connections.
The Import Connection page is displayed.
5. Enter a Name such as "InvoiceProcessingAgility".
6. Enter a Description for your new connection.
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7. Configure the Message Connector URL settings.
a. From the Windows Start menu, select Start > Kofax > Message Connector > Message
Connector Monitor.
The Message Connector Web Portal website is displayed.
b. Copy the hostname and port for the Message Connector Web Portal and then copy them into
the Message Connector URL field back on the Import Connection page.
8. Edit the other settings based on your requirements.
For more information on these settings, refer to the Kofax TotalAgility Help.
9. In the upper right corner, click OK to save your settings.
Your changes are saved, you are prompted to restart the "Kofax TotalAgility Core Worker Service".
Afterward, you are returned to the Import Connections page where your new import connector is
listed.

Configure filesystem ingestion
When Invoice Processing Agility is first installed, there are no integration settings for ingestion. As a result,
you must create the import settings before configuring each type of ingestion.
You can configure filesystem ingestion by following these steps.
1. Open the TotalAgility Designer.
2. On the Home page, click Integration.
The Integration page is displayed.
3. On the Integration page, click Import Settings.
The Import Settings page is displayed.
4. Under Import Connections, click the name that you provided when you created the connection.
The import connection you created earlier is visible but it has no Import Sources.
5. Click
next to Import Sources.
The Import Source page is displayed.
6. In the Type list, select the import source type as FILE.
7. Enter a Display Name, such as "IPAFilesystemImport".
8. Edit the settings as needed.
For more information on the individual settings, refer to the Kofax TotalAgility Help.
9. Optionally, Test File Import.
10. Ensure that the Job Type is set to Create New Job.
11. Drag-and-drop the InvoiceProcessingAgility process called Capture Document into the Process
field on your Input Source.
The Map Variables section is populated with Metadata and Initialization Variables.
12. From the Metadata column, drag-and-drop the Import Source Type Metadata so that it maps to the
Input Source.
13. Drag-and-drop the File Name Metadata so that it maps to the Filename.
You can map additional fields, but if you do, this mapping overrides the mapping configured in the
Solution Configuration Manager > Global Settings > Import Settings.
14. In the upper-right corner, click OK.
Your changes are saved and the Import Connection page is displayed with your newly created
Import Source.
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15. Click OK to close the Import Connection page.
You are prompted to restart a service.
16. Restart the Kofax TotalAgility Core Worker Service and then click OK.
17. Optionally, close the TotalAgility Designer.

Configure scan ingestion
You can configure scan ingestion, by following these steps.
1. In the Workspace menu, select IP Agility > Scan.
The Kofax Web Capture Service Required window appears.
2. Install Kofax Web Capture Service by clicking the relevant link in the window.
3. Click OK to close the window after the installation is complete.
4. Optionally, configure the settings to scan documents in languages other than English.
5. Refresh the Scan page.
This ensures that the newly installed Web Capture Service is accessible to Scan.

Configure language settings
If your invoices are in a language other than English, you can improve your extraction results by selecting
the relevant language before scanning your documents. To aid in document recognition, these languages
are available for selection at the point of scan.
• Chinese
• Japanese
• Korean
• Thai
• Greek
• Russian
Depending on which of the above languages is selected, a dedicated recognition profile is available
in Transformation Designer. Each of these languages has its own profile that is configured to extract
documents in the relevant language. Using one of these dedicated recognition profile ensures better
extraction results than the default English recognition profile. For more information on recognition profiles,
refer to the Transformation Designer Help.
You can configure scan language settings by following these steps.
1. In the Workspace menu, select IP Agility > Scan.
2. In the Language ID list, select a language.
For example, you can select the relevant language ID for Greek or Chinese documents.
3. Refer to Configure scan ingestion to complete the remaining steps of the ingestion process.

Configure email ingestion
If you plan to process documents received by one or more email address, email ingestion is necessary. An
email import process is required for each email address that you process. This is configured in the same
location as filesystem ingestion. For more information on ingestion in general, and the various settings
available, refer to the Kofax TotalAgility Help.
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You can configure email ingestion by following these steps.
1. Launch the TotalAgility Designer.
2. Click Integration.
The Manage page is displayed.
3. Click Import Settings.
The Import Settings page is displayed.
4. Click
next to Import Connections.
The Import Connection page is displayed.
5. Click
next to Import Sources.
The Import Source page is displayed.
6. In the Type list, select the import source type as POP3.
7. Enter a Display Name such as "IPAEmailImport".
8. Enter your email service provider into the Host field.
9. Enter a Username and Password.
10. Test your settings by clicking Test Mailbox.
11. Ensure that the Job Type is set to Create New Job.
12. Drag-and-drop the InvoiceProcessingAgility process called Capture Document into the Process
field on your Input Source.
The Map Variables section is populated with Metadata and Initialization Variables.
13. Drag the Import Source Type into the Input Source Mapping field.
14. Enter a Client ID.
You can either hard code a Client ID or you can select one of the Metadata variables. If you do map
a variable, you need to modify the CaptureDocument process so that it can use the Metadata value
and process it accordingly.
15. In the upper-right corner, click OK.
Your changes are saved and the Import Connection page is displayed with your newly created
Import Source.
16. Click OK to close the Import Connection page.
Your window is displayed and you are prompted to restart a service.
17. Restart the Kofax TotalAgility Core Worker Service and then click OK to close the window.
18. Optionally, close the TotalAgility Designer.
19. On your mail server, do the following.
a. In the email account specified above, enable POP download in the account settings.
b. Configure the settings to allow Invoice Processing Agility access to your email account.
Your settings are now configured to use email ingestion.

Image rendition
Rendition is used in Invoice Processing Agility to keep a copy of the originally ingested document, such as
a PDF, a 200 DPI, or a color TIFF, when the ImageProcessing activities are performed.
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The ImageProcessing activities in the main process convert all documents to 300 DPI b/w TIFF
images.
The original document is stored in the rendition.

Add image rendition
The image rendition needs to be manually added to the system and named as Original.
You can add image rendition by following these steps.
1. Open TotalAgility Designer.
2. Navigate to System Settings.
3. Select Page Renditions.
4. If no rendition is available, define one and name it Original.

Enterprise Resource Planning system connectors
If you are using an Enterprise Resource Planning (ERP) system, you can integrate it with Invoice
Processing Agility in two ways.
1. Integrate Invoice Processing Agility with AP Agility to install an ERP system.
a. Install AP Agility and then use AP Agility to install an ERP Connector.
For more information on installing AP Agility refer to the Kofax AP Agility Installation Guide.
For more information on installing an ERP Connector refer to the Kofax AP Agility
Administrator's Guide.
b. Integrate Invoice Processing Agility with AP Agility.
Note This step is necessary for an on-premise environment but not in an Azure cloud
environment. This is because the integration with AP Agility is pre-configured in an Azure
cloud environment.
2. Integrate Invoice Processing Agility directly with an ERP Connector.
To do this, perform the following steps.
a. Integrate Invoice Processing Agility with AP Agility without installing AP Agility.
Note This step is necessary for an on-premise environment but not in an Azure cloud
environment. This is because the integration with AP Agility is pre-configured in an Azure
cloud environment.
b. Download and extract the agnostic ERP connector files.
c. Update the Invoice Processing Agility client database for the ERP connector.
d. Configure the agnostic ERP web service.
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If you are using one of the following, configure its web service after the agnostic web service.
• Install the Infor Lawson ERP connector.
• Install the PeopleSoft ERP connector.
e. Configure the CSV files for the ERP Connector.
f. Configure the ERP web service logs.
g. Install the SPA package into TotalAgility.
h. Configure the ERP connection strings.
i. Update Integration Server variable for Azure.
Note This step is necessary if you are using Invoice Processing Agility in an Azure
environment only.
j. Configure the ERP web service settings.
k. Add ERP configuration menu navigation and forms.
• Add ERP connections.
• Add ERP organizations.
• Add a Business Unit for an organization.
l. Agnostic ERP integration.
m. Lawson integration.
1. Create the Lawson web service.
2. Configure the Lawson web service.
3. Configure the Lawson connection settings.
n. PeopleSoft integration.

Download and extract the Invoice Processing Agility agnostic ERP Connector
Files
If you want to use an ERP system it is necessary to add the agnostic
ERP connector manually. Before you can do this however, download the
KofaxInvoiceProcessingERPConnector-1.1.0_For_AgnosticERP.ZIP file from the Kofax eFulfillment site.
This is a basic connector that supports agnostic ERP systems only. To enable support for the Lawson or
PeopleSoft ERP systems, download the corresponding ZIP file from the Kofax e-Fulfillment site.
• KofaxInvoiceProcessingERPConnector-1.1.0_For_Lawson.ZIP
• KofaxInvoiceProcessingERPConnector-1.1.0_For_PeopleSoft.ZIP
You can extract the ERP connector zip file by following these steps.
1. Download the Agnostic ERP Connector ZIP file from the Kofax e-Fulfillment site.
2. Navigate to the downloaded ZIP file, right-click, and then select Extract.
3. When prompted, select a location for the extracted files.
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Make a note of this location for further installation steps.
4. Optionally, repeat the above steps if you are also installing another ERP connector, specifying a
separate extraction folder.

Update the Invoice Processing Agility client database for the ERP Connector
Before you can install and configure an ERP connection within Invoice Processing Agility it is necessary
to update the Invoice Processing Agility client database. These updates are necessary so that the ERP
connection is able to successfully connect with the Invoice Processing Agility client database.
Note If you are using Invoice Processing Agility in an Azure environment, the name of the database may
differ to the database name used in the steps below.
You can update the Invoice Processing Agility client database for the ERP connection by following these
steps.
1. Open Microsoft SQL Management Studio and select the InvoiceProcessingAgility_Client
database.
2. Navigate to where you extracted the ERP Connector.
3. Execute the following SQL scripts from the Database folder against the
InvoiceProcessingAgility_Client database in the order below.
• Tables_AP_Database.sql
• Views_Procedures_AP_Database.sql
• Insert_AP_Data.sql
4. Navigate to where you extracted the Invoice Processing Agility file.

Configure the agnostic ERP Connector web service
The agnostic ERP Connector uses the ERP Connector web service to exchange data between Invoice
Processing Agility and an ERP system. You can configure the ERP Connector web service by following
these steps.
1. Open Internet Information Services (IIS) Manager.
2. In the Connection page, expand http://localhost represented by the server name
A list of Application Pools and Sites is displayed.
3. Select and then right-click on Application Pools. Select Add Application Pool.
The Add Application Pool window is displayed.
4. In the Add Application Pool window, enter a name for your application pool such as
"ErpConnectorServiceAppPool".
a. From the .NET Framework version list, select .NET Framework v4.0.XXXXX.
b. From the Managed pipeline mode list, select Integrated.
c. Select Start application pool immediately.
d. Click OK.
The new application pool is created and appears in the application pool list.
5. Right-click on your newly added application pool and select Advanced Settings.
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The Advanced Settings window is displayed.
6. In the Process Model Group, set the Identity for the "ErpConnectorServiceAppPool". You cannot
use the default option. You must select either a Built-in account or a Custom account.
The Application Pool account specified here must have the following permissions.
• Read/Write/Execute permissions for the folder where the ERP Connector files are located.
• Read/Write permissions for the folder where the CSV import files are located.
• Read/Write permissions for the folder where invoices are exported.
• Read/Write permissions for the folder where the log files are created.
7. Click OK.
The Application Pool needed for the ERP Connector web service is now configured.
8. Copy the ERP Connector folder from the extracted ERP connector files to a location that is
accessible by IIS.
9. Back in IIS, expand Sites.
The Default Web Site is displayed.
10. Right-click on the Default Web Site and select Add Application.
The Add Application window is displayed.
11. In the Add Application window, enter the following settings.
a. In the Alias field, enter a name for the application such as "ErpConnector."
b. From the Application Pool, click Select and choose your newly created application pool and
click OK.
c. In the Physical path, click Browse and then navigate to where you copied the "ERP
Connector" files.
d. Optionally, test the connection.
e. Click OK.
A new web application is added to the list of applications under the Default Web Site.
If necessary, install any ERP connectors if you are using Lawson or PeopleSoft.
In addition, you can now configure an Agnostic ERP integration.

Install the Lawson ERP connector
If you are using the Lawson ERP system, it is necessary to install this connector in addition to the agnostic
ERP connector. You cannot install this connector without first configuring the agnostic ERP connector.
You can install the Lawson ERP connector by following these steps..
1. Download and extract the KofaxInvoiceProcessingERPConnector-1.1.0_For_Lawson.ZIP
ERP connector.
2. Copy the contents in the ERP Connector\bin folder from the extracted files to the ERP
Connector\bin location in IIS where you copied the agnostic ERP connector files.
The Lawson ERP connector is now ready for integration.
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Install the PeopleSoft ERP connector
If you are using the PeopleSoft ERP system, it is necessary to install this connector in addition to the
agnostic ERP connector. You cannot install this connector without first configuring the agnostic ERP
connector.
You can install the PeopleSoft ERP connector by following these steps..
1. Download and extract the
KofaxInvoiceProcessingERPConnector-1.1.0_For_PeopleSoft.ZIP ERP connector.
2. Copy the contents in the ERP Connector\bin folder from the extracted files to the ERP
Connector\bin location in IIS where you copied the agnostic ERP connector files.
The PeopleSoft ERP connector is now ready for integration.

Configure CSV files for the ERP Connector web service web.config
Now that the application pool and application are set up for an ERP Connector web service, it is
necessary to configure its web.config file so that your implementation can find the necessary CSV files.
These files are as follows.
• employee.csv
• misc_charge.csv
• taxcode.csv
• uom_conversion.csv
You can configure the ERP connector web.config file by following these steps..
1. Navigate to the "ErpConnector" folder that is referenced by IIS.
You configured this when you configured the ERP web service.
2. Open the Web.config file for editing.
3. Locate and edit the value for each of the following entries with their corresponding CSV files.
• <add key="EmployeeDataPath" value="" />
• <add key="UOMConversionPath" value="" />
• <add key="TaxCodePath" value="" />
• <add key="MiscChargeAccountDataPath" value="" />
For example, <add key="EmployeeDataPath" value="C:\Agnostic\Import
\employee.csv" />.
4. Save and then Close the Web.config file.

Configure ERP Connector web service logs
The ERP Connector web service logs issues during production. Logging settings are configured in the
ERP Connector files that are used by the web service and IIS.
By default, the ERP Connector uses the following logging configuration.
<log4net>
<appender name="FileAppender" type="log4net.Appender.FileAppender">
<param name="File" value=" "/>
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<param name="AppendToFile" value="true"/>
<maximumFileSize value="10MB"/>
<layout type="log4net.Layout.PatternLayout">
<conversionPattern value="%d %level - %message%newline"/>
</layout>
<filter type="log4net.Filter.LevelRangeFilter">
<param name="LevelMin" value="ERROR"/>
<param name="LevelMax" value="ERROR"/>
</filter>
</appender>
<logger name="ERP_CONNECTOR_LOGGER">
<appender-ref ref="FileAppender"/>
</logger>
</log4net>

By default, the minimum level is set to Error which means that entries are added to the log whenever an
error is encountered. You can change the minimum log level to Debug if you are troubleshooting the web
service as follows.
<filter type="log4net.Filter.LevelRangeFilter">
<param name="LevelMin" value="DEBUG"/>
<param name="LevelMax" value="ERROR"/>
</filter>

You can set up your own logging configuration using the log4net documentation.
You can specify where the log file is stored by following these steps..
1. Navigate to the "ErpConnector" folder that is referenced by IIS.
You configured this when you configured the ERP Connector web service.
2. Open the Web.config file for editing.
3. Locate the <log4net> section and then update the File value.
Overwrite the default value or create the necessary folder structure.
4. Save and Close the file.

ERP Connector package for Kofax TotalAgility
In order to use the ERP Connector web service, it is necessary to install the TotalAgility SPA package. You
can do this by following these steps.
1. Launch the TotalAgility Designer.
The TotalAgility Designer Home page is displayed.
2. Optionally, log on if prompted.
3. On the Home page, click Packages.
4. On the Packages page, under Import/Export, click Import Package.
5. On the Import Package page, click Browse next to Package.
6. Navigate to the location where you extracted the ERP Connector files, select TotalAgility\Package\IP
Agility ERP Connector.zip, and click Open.
The contents of the ZIP file are displayed on the Import Package page.
7. Click Import Package.
When prompted to import the package, click OK.
You are notified when the package is added to TotalAgility Designer. Click OK.
8. Click Close to close the package.
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9. Optionally, Close the TotalAgility Designer.
If you choose not to close the TotalAgility Designer, refresh the web page for your changes to take
effect.

Configure the database connection strings
The InvoiceProcessingAgility_Client database is used by the ERP Connector to import and
export data. If you are using Invoice Processing Agility in an Azure environment, tables from the Azure
database are used to import and export data.
The connection string for this database is specified in the TotalAgility server variables and global
variables. To ensure that the ERP Connector knows where to find this database, edit the connection
strings in TotalAgility by following these steps.
1. Launch the TotalAgility Designer.
The TotalAgility Designer Home page is displayed.
2. Optionally, log on if prompted.
3. On the Home page, click Data.
4. Under the Manage group, click Server Variables.
The Server Variables window is displayed.
5. From the Category Filter list at the top, select AP Agility.
A list of server variables are displayed in the table.
6. From the table, click DB Connection String.
The values of the variable are displayed above so that they can be edited.
7. Set Secure to Yes.
This ensures that the password is displayed unencrypted anywhere within TotalAgility.
When prompted, click Yes.
8. To the right of the Value field, click Configure.
The String Variable window is displayed.
9. In the text box, enter the connection string for the Invoice Processing Agility client database.
Alternatively, if you are using Invoice Processing Agility in an Azure environment, enter the
connection string for the Azure database.
Tip Use the same credentials as the Invoice Processing Agility connection strings. Refer to the
connection string from the Settings page.

10.
11.
12.
13.

For example, Data Source=<server name>;Initial
Catalog=InvoiceProcessingAgility_Client;Integrated Security=True;Connect
Timeout=30.
If you are not using Windows Authentication, set the Integrated Security to False.
In the upper-right corner, click OK.
Your connection string is saved.
Return to the TotalAgility Designer Home page.
Click Form Designer.
Under the Manage group click Global Variables.
A list of global variables are displayed for the default category.
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14. From the Category Filter list above the table, select AP Agility.
A list of global variables for AP Agility are displayed.
15. From the list of global variables, click APA_Connection_String.
The values for that global variable are loaded and editable.
16. Set Secure to Yes.
17. Review the connection string to ensure that it matches the one you added in step 9 above. Click
Update
to save your changes.
You are notified that the updated value only takes effect after the session is reloaded. Click OK.
18. From the list of global variables, click IPA_Connection_String.
The values for that global variable are loaded and editable.
19. Set Secure to Yes.
20. Review the connection string to ensure that it matches the string listed on the IPA_Settings page.
Click Update
to save your changes.
You are notified that the updated value only takes effect after the session is reloaded. Click OK.
21. Return to the TotalAgility Designer Home page.

Update Integration Server variable for Azure
If you are using Invoice Processing Agility in an Azure environment, it is necessary to update one of the
Kofax TotalAgility server variables.
This is not necessary if you are using an on-premise environment.
You can update the Kofax TotalAgility server variable by following these steps.
1. Open the TotalAgility Designer Home page.
2. On the Home page, click Data.
3. From the Category Filter list at the top, select AP Agility.
A list of server variables are displayed in the table.
4. From the table, click Is Integration Server Used.
The values of the variable are displayed above so that they can be edited.
5. If you are using Invoice Processing Agility in an Azure environment, set the Value to True.
This tells TotalAgility to use the Integration Server.
6. Click Update
to save your changes.
You are notified that the updated value only takes effect after the session is reloaded. Click OK.
7. Return to the TotalAgility Designer Home page.

Configure the web service settings in TotalAgility Designer
TotalAgility points to a default ERPConnectorService. In almost all cases, this reference needs updated
so that it matches your implementation. You can update the web service configuration in TotalAgility by
following these steps.
1. On the TotalAgility Designer Home page, click Integration.
2. Click Web Service References.
3. From the Category list, select AP Agility
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A list of web service references is displayed.
4. Click ApAgilityErpConnector.
The web service is loaded and its settings are displayed.
5. Update the path in the URL so that is points to the same location specified in IIS.
For example, https://servername/ERPConnector/ErpConnectorService.svc?wsdl.
6. In the upper-right corner, click OK.
When prompted to regenerate the proxy DLLs, click OK.
The web service is updated and its proxy DLLs are refreshed.
7. Return to the TotalAgility Designer Home page.

Add ERP configuration menu navigation and forms
Before you can connect to an ERP system using the ERP connector, it is necessary to set up both
TotalAgility and Invoice Processing Agility so that you can configure the necessary ERP connections and
organizations for your needs.
You can configure the Invoice Processing Agility workspace menu and forms by following these steps.
1. Launch the TotalAgility Designer.
The TotalAgility Designer Home page is displayed.
2. Optionally, log on if prompted.
3. On the Home page, click Form Designer.
The Form Designer page is displayed.
4. From the left Explorer pane, click Navigations.
A list of navigation options are displayed for the Default Category.
5. Select InvoiceProcessingAgility from the Category list.
A list of navigation options are displayed for the InvoiceProcessingAgility category.
6. Select InvoiceProcessingAgility category.
The menu items are displayed for the InvoiceProcessingAgility category.
7. In the Menu Items section, select InvoiceProcessingAgility.
8. Beside Menu Items, click Add
to add a new menu category to the Invoice Processing Agility
workspace.
A new menu item called MainMenu1 is added to the list under InvoiceProcessingAgility. An
editable form is displayed on the right.
9. Edit the Menu Item Name on the right by entering ERP Connector.
The menu name is updated.
10. Select ERP Connector and click Add
to add a sub-menu item, calling it ERP Organizations.
11. Select ERP Connector and click Add
to add a second sub-menu item, calling it ERP
Connections.
12. Select the ERP Connector menu item.
The editable form is displayed.
13. No form is required for this menu item, but it is necessary to configure it so that only those with the
necessary permissions are able to see this menu item.
Under Access Permissions set the Access to Deny Everyone Except.
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14. In the left Consume pane, click Back to return to the original Consume pane. Then select
Resources and then select the InvoiceProcessingAgility category.
15. Drag the IPA_Administrators resource to the Resouces field for the ERP Connector menu item.
16. In the Menu Items, select the ERP Organizations sub menu item.
The editable form is displayed.
17. From the left Consume page, select Form.
A list of forms for the Default Category is displayed.
18. Select AP Agility from the category list.
Tip If AP Agility does not appear in the category list, click Refresh
categories.
19.
20.
21.
22.
23.
24.
25.
26.
27.
28.

29.
30.

to update the list of

A list of forms for the AP Agility category is displayed.
Drag the APA_Organizations form to the Target field on the ERP Organizations form.
The Target is updated to use the selected form.
Under Access Permissions set the Access to Deny Everyone Except.
Click on the User
icon to the right of Resources and then drag in the IPA_Administrator from the
left pane.
Select the ERP Connections sub menu item.
The editable form is displayed.
From the left Consume page, select Form.
A list of forms for the Default Category is displayed.
Select AP Agility from the category list.
A list of forms for the AP Agility category is displayed.
Drag the APA_ERP_Connections form to the Target field on the ERP Connections form.
The Target is updated to use the selected form.
Under Access Permissions set the Access to Deny Everyone Except.
Click on the User
icon to the right of Resources and then drag in the IPA_Administrator from the
left pane.
In the top-left corner, click Save.
When prompted to confirm that the navigation menu is saved, click OK.
You are returned to the main Form Designer page.
Optionally, close the TotalAgility Designer.
Optionally, open the Invoice Processing Agility workspace.
The newly added menu items should be displayed if you are a member of the IPA_Admininstrators
resource group.
Tip If the menu is displayed as UNDEFINED, refresh the Invoice Processing Agility workspace
page.

Add ERP connections
You can add an ERP connection so that it is available to one or more organizations. You can add multiple
connections if you are using multiple ERP systems.
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The following information describes each field on the ERP Connections form and its purpose.
ERP Connection Name
A unique name for the ERP connection. This setting is mandatory.
Description
Provide any important details about the ERP connection. This setting is optional.
Connection Type
Select the type of ERP system from the list.
Start Data Load From
Set the date for when you want to start loading information from the ERP system.
You can add an ERP connection by following these steps.
1. Log on to the Invoice Processing Agility Workspace as a user with Administrator permissions.
The Kofax TotalAgility Workspace for Invoice Processing Agility is displayed and the newly added
ERP Connector menu is displayed.
2. From the ERP Connector menu, select ERP Connections.
The ERP Conections form is displayed.
3. At the bottom of the form, click New.
The ERP Connection: New form is displayed.
4. In the ERP Connection Name field, enter a name for this ERP connection.
For example, use the name of your ERP systems such as PeopleSoft or Lawson.
5. Enter a Description.
Provide any important information about this ERP system or its connection.
6. Select your Connection Type from the list.
7. Set the Start Data Load From date.
8. Click Save.
A message indicates when your new connection is created.
9. Click Close.
You can now see your newly created connection listed in the ERP Connections.
10. Optionally, add another connection by clicking New.
Alternatively, click Close to return to the Invoice Processing Agility Workspace.

Add ERP organizations
Before you can add an organization, a connection is required.
The following information describes each field on the Organization form and its purpose.
ERP Connection
Select the ERP connection from the list. This setting is mandatory.
Organization Name
A unique name for the organization. This name may differ from the name in the ERP system.
This setting is mandatory.
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Description
Provide any important details about the organization. This setting is optional.
ERP Organization ID
The ID that the ERP system uses to identify the organization. This setting is used to associate the Invoice
Processing Agility organization with the corresponding entity in the ERP system.
This setting must be unique and it is mandatory.
ERP Organization Name
The organization name used in the ERP system. This setting is optional and is needed only when the
Organization Name provided above differs from the ERP Organization Name.
This setting is optional.
IPA Client Name
Select the name of the Invoice Processing Agility client associated with this organization from the list of
available clients.
This setting is mandatory.
Active
Select to activate the organization.
You can add an ERP organization by following these steps..
1. Log on to the Invoice Processing Agility Workspace as a user with Administrator permissions.
The Kofax TotalAgility Workspace for Invoice Processing Agility is displayed and the newly added
ERP Connector menu is displayed.
2. From the ERP Connector menu, select ERP Organizations.
The ERP Organizations form is displayed.
3. At the bottom of the form, click New.
The Add Organization form is displayed.
4. On the Organization tab, select an ERP Connection that was added earlier.
5. Enter the Organization Name.
6. Enter a Description.
7. Enter the ERP Organization ID.
8. Enter the ERP Organization Name.
9. Select the IPA Client Name from the list.
10. Select Active to enable this organization.
11. Click Add.
The newly added organization is displayed in the list and the Business Units tab is enabled.
12. Optionally, add one or more business units.
13. Click Close.
The Organizations list is displayed.
14. Click Close.
The Invoice Processing Agility Workspace is displayed.
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Add a Business Unit for an organization
Organizations can have one or more business units. A business unit may correspond with an
organizational unit, department, or business area. This depends on your ERP system hierarchy.
The following information describes each field on the Business Unit form and its purpose.
Business Unit Name
A unique name of the business unit as used in Invoice Processing Agility. This name may differ from the
business unit name used in the ERP system.
This setting is mandatory.
Description
Provide any important details about the organization. This setting is optional.
ERP Business Unit ID
The ID that the ERP system uses to identify the business unit. This setting is used to associate the Invoice
Processing Agility business unit with the corresponding entity in the ERP system.
This ID is associated with the Invoice Processing Agility Company Code so it can determine what
business unit receives the routed invoice.
This setting must be unique and it is mandatory.
ERP Business Unit Name
The name of the business unit used in the ERP system. This name may be used to match the Invoice
Processing Agility Company Code in case a match is not possible using the ERP Business Unit ID.
This setting is optional.
Business Unit Address
The business unit address.
Country
The business unit country.
Currency
The business unit currency.
Active
Select to activate the organization so that output files are generated.
If this is not selected, then export does not generate any output files.
You can add one or more business units
1. Log on to the Invoice Processing Agility Workspace as a user with Administrator permissions.
The Kofax TotalAgility Workspace for Invoice Processing Agility is displayed and the newly added
ERP Connector menu is displayed.
2. From the ERP Connector menu, select ERP Organizations.
The ERP Organizations form is displayed.
3. From the list of Organizations, select the specific organization where you are adding the Business
Units.
4. Click on the Business Units tab.
The Business Units form is displayed.
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5. Click New.
The form is updated.
6. Enter a Business Unit Name.
7. Enter a Description.
8. Enter an ERP Business Unit ID.
9. Enter an ERP Business Unit Name.
10. Enter the Business Unit Address.
11. Select a Country for this Business Unit.
12. Select the Currency for this Business Unit.
13. Select Active to enable this Business Unit.
14. Click Add.
This Business Unit is now shown on a list.
15. Click Close.
The list of business units is displayed with your newly added business unit.
16. Optionally, click New to add another business unit.
17. Click Close
The Organizations list is displayed.
18. Click Close.
The Invoice Processing Agility Workspace is displayed.

CSV file format
The format of the CSV files used by Invoice Processing Agility and ERP systems requires that the fields
are in the order specified. The CSV files themselves must contain a header and the fields must be
separated by a comma.
The following CSV files may be used when integrating with an ERP system.
• Vendors CSV file format
• PO headers CSV file format
• PO Lines CSV file format
• Plants CSV file format
• Receipt Lines data format
• Employee file format
• Miscellaneous Charge file format
• Tax Code file format
• Unit of Measure Conversion file format

Vendors CSV file format
This CSV file is called vendors.csv and requires comma separated content in the following format.
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Field Index

Column Name

Type

Description

1

ErpVendorId

String

This is the unique Vendor ID in ERP.

2

ErpBusinessUnitId

String

Business unit ID in ERP (company code).

3

ErpTermId

String

The ERP term ID for the vendor.

4

Description

String

A description of the vendor so that it can be
differentiated from other vendors.

5

VendorName

String

The vendor name.

6

VendorSiteId

String

The vendor site ID, if applicable.

7

VendorSiteCode

String

The vendor site code.

8

VendorStreet1

String

The first line of the vendor address.

9

VendorStreet2

String

The second line of the vendor address, if
applicable.

10

VendorCity

String

The City of the vendor address.

11

VendorZip

String

The post code or zip code of the vendor
address.

12

VendorState

String

The state or region of the vendor address.

13

VendorCountry

String

The vendor country.

14

VendorVatCode

String

The vendor VAT code.

15

VendorVatRegno

String

The vendor VAT registration number.

16

TaxNumber

String

The vendor tax number.

17

BankCode

String

The Bank code for the vendor.

18

BankAccountNumber

String

The Bank account number for the vendor.

19

Email

String

The Email for the vendor contact.

20

Url

String

The URL for the vendor.

21

Telephone

String

The Telephone for the vendor contact.

22

Fax

String

The fax number for the vendor.

23

ContactName

String

A contact name for the vendor.

24

Active

Bit

When set to TRUE, the vendor is active.

25

Enabled

Bit

When set to TRUE, the vendor is enabled.

The unique ID is from the point-of-view of the
data extract where each row must have a unique
reference. This is not the unique vendor ID from
the point-of-view of the ERP system if a site ID is
also used.

This is given as an ISO 3166 Alpha-2 character
code. For example, UK for the United Kingdom
or US for the United States.
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Field Index

Column Name

Type

Description

26

TermDateBasis

Bit

The term date basis of the vendor.
• Invoice
• Goods Received
• Current
• Invoice received

27

PoBox

String

The PO Box of the vendor address, if applicable.

28

PoBoxZip

String

The PO Box Zip code of the vendor address, if
applicable.

29

EuMember

String

A value of 1 indicates that the vendor is from
a country that is an EU Member. A value of 0
indicates that the vendor country is not an EU
Member.

30

Currency

String

The currency of the vendor country.

31

TaxId1

String

The primary tax ID for the vendor.

32

TaxId2

String

The secondary tax ID for the vendor.

33

TaxJurCode

String

The tax jurisdiction code

34

InvoiceType

String

The vendor invoice type.

35

PaymentMethods

String

A list of bank payment methods for the vendor.

36

WithholdingTaxDetails

String

Any withholding tax details for the vendor.

37

CompanyCodes

String

A comma-separated list of company codes that
are valid for the vendor.

38

UtilityFlag

String

Indicates if the vendor is a utility vendor.

39

PorSubscriberNo

String

The Swiss purchase order subscriber number for
the vendor, if applicable.

40

ExternalSiteId

String

The external site ID

41

VendorAccountGroup

String

The vendor account group.

42

AlternatePayee

String

An alternate payee for this vendor.

43

PermittedPayee

String

A list of permitted payees for this vendor.

44

SiretId

String

The French Siret ID for this vendor, if applicable.

45

VendorIdentifier

String

A unique vendor identifier, such as a Chinese
tax registration number.

46

InterCompany

Bit

A value of 1 indicates that the vendor is an
intercompany vendor. A value of 0 means that
the vendor is not an intercompany vendor.

47

ErpBankAccountCode

String

The ERP Bank Account Code for the vendor.

This content is found in the VENDOR_MASTER_DATA database table in the
InvoiceProcessingAgility_Client database that was added when you integrated Invoice
Processing Agility with AP Agility.
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PO headers CSV file format
This CSV file is called po_headers.csv and requires comma separated content in the following format.
Field Index

Column Name

Type

Description

1

ErpPoHeaderId

String

The unique PO header ID in the ERP.
This can repeat the PO document number field if
the document number is unique in the ERP .
This number is used to match the PO line to the
PO header during data load.

2

ErpBusinessUnitId

String

The business unit ID in the ERP (company
code).

3

PoNumber

String

The PO number.

4

PoType

String

The type of PO. This is either,
• MATERIAL
• SERVICE

5

ErpVendorId

String

The vendor ID in the ERP.

6

VendorName1

String

The name of the vendor.

7

VendorSiteId

String

The vendor site ID.

VendorSiteCode

String

PoStatus

String

Active

Bit

8

9
10

This should be empty if your ERP does not
support vendor sites.
The vendor site code.
This should be empty if your ERP does not
support vendor sites.
The status of the PO.
For example, released, suspended, closed, etc.
If the value is 1, the PO is active.

This content is found in the PO_HEADER database table in the InvoiceProcessingAgility_Client
database that was added when you integrated Invoice Processing Agility with AP Agility.

PO Lines CSV file format
This CSV file is called po_lines.csv and requires comma separated content in the following format.
Field Index

Column Name

Type

Description

1

ErpPoLineId

String

The PO line ID used in the ER for the PO line
item.

2

ErpBusinessUnitId

String

Business unit ID in the ERP for the PO line item.

3

ErpPoHeaderId

String

The PO header ID in the ERP for the PO line
item.

4

PoNumber

String

The PO number for the PO line item.
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Field Index

Column Name

Type

Description

5

LineNumber

Number

The line number for the PO line item.

6

MaterialNumber

String

The material number for the PO line item.

7

MaterialGroup

String

The material group for the PO line item.

8

Description

String

A description of this particular PO line item.

9

PoQuantity

Number

The order quantity for the PO line item.

10

UnitPrice

Number

The unit price for the PO line item.

11

PoTotal

Number

The overall total for the PO line item.

12

TaxCode

String

The tax code for the PO line item.

13

TaxJurCode

String

The tax jurisdiction code for the PO line item.

14

UnitOfMeasure

String

The unit of measure for the PO line item.

15

PriceUnit

Number

The price unit for the PO line item.

16

Puom

String

The price unit of measure for the PO line item.

17

TotalQuantityDelivered

Number

The total quantity delivered to date for the PO
line item.

18

TotalValueDelivered

Number

The total value delivered to date for the PO line
item.

19

TotalQuantityInvoiced

Number

The total quantity invoiced to date for the PO line
item.

20

TotalValueInvoiced

Number

The total value invoices to date for the PO line
item.

21

ItemCategory

String

Item category or line item type of the PO line
item.

22

Plant

String

The location code for the ship-to address where
the goods were delivered, or where a service
was performed.

23

ChargeCode

String

The charge code for the corresponding PO line
item.

24

ChargeCodeId

String

The charge code ID.

25

ErpPoType

String

This is the PO type for JD Edwards purchase
order line items.

26

Ers

String

Indicates if an ERS system is used. This is a
SAP-specific field.
A value of X indicates that the ERS system is
used. An empty value indicates that the ERS
system is not used.

27

ReceiptRequired

Bit

A flag that indicates if a receipt is required.
If the value is 1, a receipt is required.

This content is found in the PO_LINES database table in the InvoiceProcessingAgility_Client
database that was added when you integrated Invoice Processing Agility with AP Agility.
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Plants CSV file format
This CSV file is called plants.csv and requires comma separated content in the following format.
Field Index

Column Name

Type

Description

1

PLANT_ID

String

The plant ID. This must be unique in the CSV.

ERP_ORGANIZATION_ID

String

COUNTRY_CODE

String

2

3

This matches the Plant field specified for PO
lines. It is exported as the invoice line Plant field.
The Organization ID of the plant.
If an organization ID is not provided, the plant is
created and then linked to the same organization
as the ERP Connection.
The two-character ISO country code for the
plant.
Entries with an empty country code are skipped
during the import process.

4

STATE_CODE

String

The state code of the Plant.
This is where the plant is located. For the United
States, use the two-character state code such as
CA for California.

This content is found in the PLANTS database table in the InvoiceProcessingAgility_Client
database that was added when you integrated Invoice Processing Agility with AP Agility.

Receipt Lines data format
This CSV file is called receipt_lines.csv and requires comma separated content in the following
format.
Field Index

Column Name

Type

Description

1

BusinessUnit

String

The business unit ID in the ERP (company
code).

2

PoNumber

String

The PO number.

PoLineNumber

String

3

This is used during line pairing to match the
receipt line to the PO number. (See PO Lines
CSV file format.)
The ERP PO line number.
This is an ERP-specific line ID in the PO, such
as the line number. It must be unique among
lines for the PO. In some ERP systems it may be
simply the line number such as 1, 2, or 3.
This is used during line pairing to match the
receipt line to the number of PO line. (See PO
Lines CSV file format.)
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Field Index

Column Name

Type

Description

4

ErpReceiptId

String

The ERP receipt ID.

ReceiptLineNumber

String

6

DeliveryDocumentNumber

String

The delivery document number.

7

Quantity

Double

The quantity of the line item.

8

UnitPrice

Double

The unit price of the line item.

9

Total

Double

The total amount of the line item.

10

QuantityInvoiced

Double

The quantity invoiced for the line item.

11

TotalInvoiced

Double

The total invoiced for the line item.

12

DocYear

String

The year specified on the receipt.

5

This is used by Invoice Processing Agility as
the receipt number (DOC_NO field) during line
pairing. For the line paired invoice lines, it is
exported as GRDocNo tag.
The ERP receipt item number.
This is used by Invoice Processing Agility as
the receipt item (DOC_ITEM field) during line
pairing. For paired invoice lines, it is exported as
the GRDocItem tag.

This content is found in the RECEIPT_LINES database table in the
InvoiceProcessingAgility_Client database that was added when you integrated Invoice
Processing Agility with AP Agility.

Employee file format
This CSV file is called employee.csv and requires comma separated content in the following format.
Field Index

Column Name

Type

Description

1

IndexId

String

A unique key for employee addresses across all
partitions. This IndexID is a compound string
that is made up from the PartitionID and the
ID (Employee).

The PartitionID and the ID are separated by
a hyphen (-).
This value is mandatory.
2

PartitionID

Number

The Employee partition. This is used to
distinguish Employees from different sources.
This value is mandatory.

ID

String

4

Name

String

The Employee name.

5

Address1

String

The first line of the Employee address.

6

Address2

String

The second line of the Employee address.

3

The Employee ID that is used in the ERP.
This value is mandatory.

72

Kofax Invoice Processing Agility Installation Guide

Field Index

Column Name

Type

Description

7

City

String

The Employee city.

8

Zip

String

The Employee post code or zip code.

9

State

String

The Employee state or region.

10

Country

String

The Employee country.

11

TelNo

String

The Employee telephone number.

12

TaxID1

String

The Employee primary tax code.

13

TaxID2

String

The Employee secondary tax code.

This must be given as an ISO 3166 Alpha-2
character code.

This content is found in the BRWEmployeeMaster database table in the
InvoiceProcessingAgility_Client database.

Miscellaneous Charge file format
This CSV file is called misc_charge.csv and requires comma separated content in the following format.
Field Index

Column Name

Type

Description

1

POPARTITION

Number

The PO partition ID for the line item.

COMPANYCODE

String

CATEGORY

String

4

PLANT

String

The plant used for the line item.

5

LINETYPE

String

The line type of the line item.

6

GLACCOUNT

String

The GL account number for the line item.

7

COSTCENTER

String

The cost center for the line item.

8

PROFITCENTER

String

The profit center for the line item.

9

TAXCODE

String

The tax code for the line item.

2
3

This value is mandatory.
The company code for the line item.
This value is mandatory.
The category of the charge for the line item.
This value is mandatory.

This content is found in the MiscChargesAccount database table in the
InvoiceProcessingAgility_Client database that was added when you integrated Invoice
Processing Agility with AP Agility.

Tax Code file format
This CSV file is called taxcode.csv and requires comma separated content in the following format.
Field Index

Column Name

Type

Description

1

PARTITIONID

Number

The partition ID.
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Field Index

Column Name

Type

Description

2

VENDORID

String

The vendor ID.

3

COUNTRY

String

The two-character country code used on the
invoice.
This value is mandatory.

4

SHIPTO

String

Two-character code of the country where the
item was shipped.
This value is mandatory.

5

SHIPFROM

String

Two-character code of the country where the
item was shipped from.
This value is mandatory.

6

SERVICE

String

If this is a service, a value of Y is expected. For
a non-service, a value of N is used.

7

MATERIALNO

String

The line item material number.

8

MATERIALGROUP

String

The line item material group.

9

PERCENTAGE

Number

The line item tax percentage.

TAXCODE

String

10

This value is mandatory.
The line item tax code.

This content is found in the TaxCode database table in the InvoiceProcessingAgility_Client
database that was added when you integrated Invoice Processing Agility with AP Agility.

Unit of Measure Conversion file format
This CSV file is called uom_conversion.csv and requires comma separated content in the following
format.
Field Index

Column Name

Type

Description

1

POPartition

Number

The PO partition number.

MATERIAL_NO

String

BASE_UOM

String

NUMERATOR

String

2
3
4

This value is mandatory.
The material number for the PO line item.
This value is mandatory.
The base unit of measure for the PO line item.
This value is mandatory.
The numerator for the unit of measure for the
PO line item.
This value is mandatory.

5

DENOMINATOR

String

The denominator for the unit of measure for the
PO line item.
This value is mandatory.

6

EXTERNAL_UOM

String

The external unit of measure for the PO line
item.
This value is mandatory.
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This content is found in the BRWUOMConversions database table in the
InvoiceProcessingAgility_Client database.

Agnostic ERP integration
Once you have added an ERP connection and assigned it to an organization, you can use these to
integrate your Agnostic ERP with Invoice Processing Agility.
You can integrate your Agnostic ERP with Invoice Processing Agility by following these steps.
1. Create an ERP connection as shown in Add ERP connections.
2. Add an organization to use the above ERP connection as shown in Add ERP organizations.
3. Locate the web.config file in the web folder used by the ErpConnector service and open it with a text
editor.
4. Ensure that your web.config file is configured as follows.
a. Under <configuration><erpConnector><plugins> add a <plugin> element for your
Agnostic ERP connection as follows.
<plugin type="Files">
<class>Kofax.ApAgility.ErpConnector.Files.Plugin,
Kofax.ApAgility.ErpConnector, Version=1.0.0.0, Culture=neutral,
PublicKeyToken=0a00a7449ea4c480”</class>
</plugin>

Note There can be one Agnostic plugin only.
b. Under <configuration><erpConnector><connections> add a <connection> element
and sub-elements for your Agnostic ERP connection as follows.
<connection name="AgnosticERPName" type="Files">
<add name ="input_path" value="C:\Agnostic\Import" />
<add name ="output_path" value="C:\Agnostic\Export" />
<add name ="apply_xslt" value="false" />
<add name ="xslt_path" value="C:\Agnostic\example.xslt" />
</connection>

For the <connection>, the name attribute must match the name of the ERP connection
defined when you added the ERP connection.
The type attribute in <connection> should match the type attribute in <plugin>.
For each of the <add> elements, provide the following values.
• input_path: Enter the path to the folder that contains the master data files used for import.
Note This does not include the following CSV files.
• employee.csv
• misc_charge.csv
• taxcode.csv
• uom_conversion.csv
See Configure CSV files for the ERP Connector web service web.config for instructions on
how to configure these additional CSV files.
• output_path: Enter the path to where the invoice data is exported.
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• apply_xslt: Set this value to true if you are using an XSLT to transform the data. If you do
not want to transform the data set the value to false.
• xslt_path: Enter the path for the XSLT transform. If apply_xslt is set to false, this value
is ignored.
Note The paths specified here much be accessible to Invoice Processing Agility
c. Save the web.config file.

Lawson integration
Once you have added an ERP connection and assigned it to an organization, you can use these to
integrate your Lawson ERP with Invoice Processing Agility.
You can integrate your Lawson ERP with Invoice Processing Agility by following these steps.
1. Prerequisites for Lawson integration.
2. Create the Lawson web service.
3. Configure the Lawson connection string.
4. Configure the Lawson web service.
5. Lawson data import and export configuration.
6. If necessary, adjust the AGS invoice export configuration.
7. If necessary, adjust the Master data retrieval configuration.

Prerequisites for Lawson integration
Before you can configure the Lawson connector, the following prerequisites are necessary.
1. The user defined when you create the web service requires READ permissions for the following
Lawson tables.
• APVENLOC
• APINVOICE
• PORECLINE
• GLCHARTDTL
• APVENMAST
• TERMS
• APCOMPANY
• ACACTIVITY
• POLINE
•
•
•
•
•
•

APPAYMENT
GLSYSTEM
ACACCTCAT
PURCHORDER
MAINVDTL
GLNAMES
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2. The configured user also requires ADD, CHANGE, and DELETE access for the following screens.
• AP20.2
• MA43.1
• MA43.3
3. .NET 4.5.2 is required in order to use the Lawson connector.

Create Lawson web service
Before you can make use of the Lawson ERP Connector, it is necessary to create the web service using
the files provided.
You can create the Lawson web service by following these steps.
1. Install the Lawson ERP connector.
a. In the unzipped files, navigate to the ERP Integration\Lawson folder.
The KofaxConnector_For_Lawson.zip file is displayed.
b. Extract KofaxConnector_For_Lawson.zip.
You can provide your own folder name or use the default name provided during extraction.
The folder is extracted. Use this to copy the project.

2.
3.
4.
5.

c. Copy the extracted folder from the previous step to a location that is accessible by IIS.
For example, C:\inetpub\wwwroot.
Launch IIS.
In the Connections pane, expand http://localost represented by your computer name.
A list of Application Pools and Sites is displayed.
Select and then right-click on Sites. Select Add Website.
The Add Website window opens.
In the Add Website window, enter the following information.
a. In the Site name field, enter a name for your web service.
For example, KTA Lawson Connector.
b. For the Application Pool, click Select and then choose .NET v4.5 from the list.
c. In the Physical Path, click on the Browse button and navigate to and select the folder you
copied in step 1.c.
d. Configure the other settings as required.
For example, set the Binding Port to 9810.

e. Ensure that the Start Website immediately option is selected and then click OK.
The website is created and listed under Sites.
6. Select your newly created website.
The central Home pane is updated for your site.
7. In the central Home pane, under IIS, double-click on Authentication.
The Authentication settings are displayed.
8. Ensure that Basic Authentication is enabled.
If necessary, right-click on Basic Authenitcation and select Enable.
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If you cannot find Basic Authentication in your website, make sure that Basic Authentication is
enabled in IIS by following these instructions.
https://docs.microsoft.com/en-us/iis/configuration/system.webserver/security/authentication/
basicauthentication.
A warning message is displayed because you are not using an SSL.
9. Enable SSL for your website as follows.
a. In the Connections panel, right-click on your website and select Edit Bindings.
The Site Bindings window is displayed.
b. In the Site Bindings window, click Add.
The Add Site Binding window s displayed.
c. In the Add Site Binding window, specify the following.
Set Type to https.
• Set the Port to any available port.
• Set the SSL certificate to a valid certification.
d. Click OK.
Your newly added binding is listed on the Site Bindings window.
e. Click Close.
The Site Bindings window is closed.
Your website is now configured for SSL connections.
10. Test your installation as follows.
a. Edit the website Web.config file so that the KtaService:UseMockData setting is set to true.
b. In a web browser go to https://localhost:<port number>/testConection.
Where <port number> matches the port you specified in step 10 c.
c. When prompted, enter the Username and Password for any Windows user.
If the connection is successful, the following is displayed.
<?xml version="1.0"?>
<ConnectorTestStatus xmlns="http://schemas.datacontract.org/2004/07/
KtaConnector.Services" xmlns:i="http://www.w3.org/2001/XMLSchema-instance">
<AdditionalInformation/>
<ErrorCode>NONE</ErrorCode>
<IsSucceeded>true</IsSucceeded>
<Message/>
</ConnectorTestStatus>

If the testing fails, review the previous steps and try again.
Your web service website is ready for configuration.

Configure Lawson web service
Now that the web service is installed and its connection string is referenced in the web.config file, it is
necessary to configure the web service.
You can configure the Lawson web service by following these steps..
1. Restart the Lawson web service that you recently created.
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2. Navigate to the Lawson web service <serviceFolder>/Services/Connectors/Lawson/lib
folder and open the RPILawsonCOM_Config.xml file for editing.
3. In the RPILawsonCOM_Config.xml file, edit the following parameters.
Parameter Name

Description and Examples

LawsonAuth

The authentication method.
Choose between one of the following two authentication types.
• PREMISES - Enter this value if you are using Invoice Processing
Agility on-premise.
• CLOUD - Enter this value if you are using Invoice Processing Agility in
an Azure environment.

Username

The username of the Lawson user used by the connector for
authentication.

Password

The password of the Lawson user used by the connector for
authentication.

ProductLine

The product line to use when querying Lawson.

LawsonDMEPath

The relative path to the Lawson data servlet.

LawsonAGSPath

The relative path to the Lawson transaction servlet.

LawsongWriteAttachPath

The relative path to the Lawson writeAttach executable.

LawsonGetAttachPath

The relative path to the Lawson getAttach execuatble.

LawsonBaseURL

The base URL where Lawson is listing for requests.

For example, "/servlet/Router/Data/Erp?".
For example, "/servlet/Router/Transaction/Erp?".
For example, "/cgi-lawson/writeattache.exe".
For example, "/cgi-lawson/getattachrec.exe".
For example, https://100.11.12.13.

If you are using Invoice Processing Agility in an Azure environment, also edit the following cloudspecific parameters.
Parameter Name

Description and Examples

LandmarkBaseURL

The URL of the landmark instance that the Lawson connector uses for
authentication.

CloudAdfsUrl

The URL that is used in the third step of the Lawson connector
authentication process.

CloudBaseUrl

The URL that is used in the fourth step of the Lawson connector
authentication process.

4. Save and then Close the RPILawsonCOM_Config.xml file.
5. Open the web.config file for editing. This file was created when you created the web service.
6. Edit the web.config file so that the KtaService:UseMockData setting is set to false.
This ensures that the web service no longer uses mock data.
7. Save and Close the web.config file.
Your Lawson web service is now ready for use.
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Configure the Lawson connection settings
Now that the web service website is available, configure the web.config so that it points to the newly
added web service.
You can configure the Lawson connection string by following these steps.
1. Open the Invoice Processing Agility Workspace.
2. Create an Lawson ERP connection as shown in Add ERP connections.
3. Add an organization to use the above ERP connection as shown in Add ERP organizations.
4. Locate the web.config file in the web folder used by the ErpConnector service and open it with a text
editor.
a. Under <configuration><erpConnector><plugins> locate the <plugin> with the type
Lawson.
Ensure that the default plugin is as follows:
<plugin type="Lawson"
class="Kofax.ApAgility.ErpConnector.Plugins.InforLawson.InforLawsonErpPlugin,
Kofax.ApAgility.ErpConnector.Plugins.InforLawson, Version=1.0.0.0,
Culture=neutral, PublicKeyToken=0a00a7449ea4c480"/>

Note There can be one Lawson plugin only.
b. Under <configuration><erpConnector><connections> add a <connection> element
and sub-elements for your Lawson ERP connection as follows.
<connection name="Lawson" type="Lawson">
<add name="url" value="https://localhost:9443"/>
<add name="authentication_type" value="Basic"/>
<add name="username" value="LawsonAdmin"/>
<add name="password" value="password"/>
<add name="page_size" value="1000"/>
<add name="zip" value="1"/>
</connection>

For the <connection>, the name attribute must match the name of the ERP connection
defined when you added the ERP connection.
The type attribute in <connection> should match the type attribute in <plugin>.
For each of the <add> elements, provide the following values.
• url: Enter the URL to the Lawson service.
• authentication_type: Enter either Basic or Windows. If you specify Basic, enter the
username and password attributes. If you enter Windows, leave username and password
empty.
• page_size: Enter a positive integer with the mount of master data records that are returned
by the web service for each call.
For example, if page_size is set to 1000 and the number of vendors in the Lawson ERP
is 5000, the Lawson ERP plugin makes 5 requests to the web service. Each time the web
service returns 1000 records of data.
• zip: Enter 1 to have the Lawson service compress archive data before it is returned. Enter 0
to leave the archive data uncompressed.
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Note The paths specified here must be accessible to Invoice Processing Agility
c. Save the web.config file.

Lawson data import and export configuration
The Lawson connector uses the Lawson Data Service (DME) to retrieve AP master data. It also uses the
Lawson Application Gateway Service (AGS) to export invoice data into Lawson. The DME queries are
defined in the RPILawsonCOM.config.xml file.
The AGS scripts are used to export NON-PO, credit, and PO-based invoices.
The DME queries and AGS calls are adjustable based on your requirements and how Lawson is
configured.
By default, import and export have a default configuration. However, you can adjust these settings as
needed for your installation.

AGS invoice export configuration
The AGS Export uses the XSLT 1.0 transform the incoming XML from Kofax into a set of transactions
required to process invoices in Lawson. See Lawson AGS export mapping - Invoice Header fields and
Lawson AGS export mapping - Invoice Line fields for additional mapping details.
Note After a configuration change restart the Lawson web service for the change to take effect.
NON-PO/CREDIT Transaction
File Location: \Services\Connectors\Lawson\lib\Invoice_Add_NonPO.xslt.
Example 1.
<API-INVOICE>
<xsl:value-of select="translate(InvoiceNumber,'abcdefghijklmnopqrstuvwxyz',
'ABCDEFGHIJKLMNOPQRSTUVWXYZ')"/>
</API-INVOICE>

Example 2.
<API-INVOICE-TYPE>
<xsl:if test="DocumentType = 'CREDIT'">C</xsl:if>
<xsl:if test="DocumentType != 'CREDIT'"></xsl:if>
</API-INVOICE-TYPE>

PO Match Transaction
File Location: \Services\Connectors\Lawson\lib\Invoice_Add_PO.xslt.
Example 1.
<PT-MAD-LINE-NBR><xsl:value-of select="substring-after(GrDocNo,'-')"/></PT-MAD-LINENBR>

Example 2.
<MAD-ENTERED-QTYr0><xsl:value-of select="Quantity"/></MAD-ENTERED-QTYr0>
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Master data retrieval configuration
Lawson Data Service (DME) is a service that provides dynamic, read-only access to Lawson data. When
a user makes a request from the Lawson Portal or another location, DME makes calls to the database and
returns the requested data ensuring that the security rules are enforced. DME retrieves data and sends
it back to the requesting client. By default, the format of the data sent back is XML. However, this can be
modified to CSV format if necessary.
This data retrieval does not support data updating.
Note After a configuration change restart the Lawson web service for the change to take effect.
Data query configuration
File Location: \Services\Connectors\Lawson\lib\RPILawsonCOM_config.xml
DME queries specified in the config file should not be edited in most cases. However, there are some
cases were it may be necessary to adjust the configuration. Specifically, it may be necessary to update
the SELECT clause in the DME query to filter results or add additional customer user fields that re
used. Existing data columns should not be removed. DME queries must be URL encoded in the XML
configuration file.
Vendors query example.
<item key="APVenMast">
<Query QueryMode="Xml">
<QueryURL>FILE=APVENMAST&amp;FIELD=VENDOR%2DSNAME;TAX%2DID;REMIT%2DTO
%2DCODE;VENDOR;VENDOR%2DGROUP;VENDOR%2DVNAME;VDR%2DADDR1;VDR%2DADDR2;VDR%2DCITY
%2DADDR5;VDR%2DCOUNTRY;VDR%2DPOSTAL;VDR%2DSTATE;VAT%2DREG%2DCTRY;VAT%2DREG%2DNBR;BANK
%2DID;VBANK%2DACCT%2DNO;E%2DMAIL%2DADDRESS;PHONE%2DNUM;VENDOR%2DCONTCT;BANK
%2DENTITY;VDR%2DADDR3;DISC%2DCALC%2DDATE;INV%2DCURRENCY;BANK%2DINST%2DCODE;CASH
%2DCODE;VAT%2DREG%2DCTRY;REQUIRE%2DPO;TERM%2DCODE;URL%2DADDR&amp;SELECT=VENDOR%2DGROUP
%3DVEN%7CVENDOR%2DGROUP%3D4321&amp;OUT=XML&amp;NEXT=TRUE&amp;{0}</QueryURL>
</Query>
</item>

Adding data filtering to the DME queries
In the Vendors query example above we can see that there is filtering applied with a SELECT statement in
the query.
"SELECT=VENDOR%2DGROUP%3DVEN%7CVENDOR%2DGROUP%3D4321"
This is a URL encoded version for "SELECT=VENDOR-GROUP=VEN|VENDOR-GROUP=4321".
For more information, see the Lawson Doc for Developers: IOS Application Program Interfaces.
Invoices query example.
<item key="APInvoice">
<Query QueryMode="Xml">
<QueryURL>FILE=APINVOICE&amp;FIELD=APPAYMENT%2ECHECK%2DDATE;APPAYMENT%2EVOID
%2DDATE;APPAYVENMAST%2EVENDOR%2DSNAME;APPAYVENMAST%2EREMIT%2DTO%2DCODE;OBJ
%2DID;VENDOR;COMPANY;INVOICE;CANCEL%2DDATE;INVOICE%2DDTE;INVOICE%2DTYPE;BASE%2DINV
%2DAMT;PO%2DNUMBER;REC%2DSTATUS;APPAYVENMAST%2EVENDOR;&amp;OUT=XML&amp;NEXT=TRUE&amp;
{0}</QueryURL>
</Query>
</item>

In the Invoices query above there is no SELECT clause. This means that for the specific Lawson instance,
no filtering is required. A SELECT clause can be added if necessary.
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Lawson AGS export mapping - Invoice Header fields
The following table explains the invoice header export fields used by the Lawson AGS.
Tag

Description

Lawson API
Field

Interface
Notes

Invoice

The root XML tag

Invoice/AccountNumber

The account number field has a unique
N/A
identification number for a client from the vendor
point-of-view. See IPA Administration Guide for
additional information.

N/A

Invoice/AlternatePayee

This field is a supplementary field to the Vendor
ID. It represents the party that receives invoice
payments, and is not necessarily the vendor
listed on the invoice. This payee must be on
a list of pre-defined permitted payees for the
extracted Vendor. See IPA Administration Guide
for additional information.

N/A

Lawson
Handles
"Payment
Vendor"
in internal
setup and not
during Invoice
Creation

Invoice/AlternatePayeeAddress Not used for export in ERP.

N/A

N/A

Invoice/AmtMiscellaneous

Not used for export in ERP.

N/A

N/A

Invoice/AmtWithholdingTax

The withholding tax amount fields capture the
portion of the invoice total that is withheld by the
client for legal reasons and not paid back to the
vendor.

N/A

N/A

Invoice/AmtPst

This field captures the Provincial Sales Tax
(ProvincialSalesTax/QST) component of
Canadian tax.

N/A

N/A

Invoice/ApproveTime

Time when the invoice has been approved in
APA

N/A

N/A

Invoice/ApproverName

Approver name who approved the invoice in
APA

N/A

N/A

Invoice/BankAccount

The bank account number captures where the
vendor wants to be paid.

N/A

Handled
in Lawson
Vendor Setup
not during
Invoice
Creation

Invoice/BankAccountCode

The bank account code represents the
identification of the bank account for that vendor
from the point-of-view of the downstream ERP
system.

N/A

Handled
in Lawson
Vendor Setup
not during
Invoice
Creation

Invoice/BIC

The BIC or SWIFT code is an internationally
assigned code to identify a unique banking
institution.

N/A

N/A
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Tag

Description

Lawson API
Field

Interface
Notes

Invoice/BillToName

This field represents the name of the invoice
recipient. This field is used to check that the
incoming document is intended for a valid
company within a client organization.

N/A

N/A

Invoice/BillToVatRegNo

The Vendor VAT Registration Number and Bill-to N/A
VAT Registration Number are available to satisfy
a European legal/fiscal compliance ruling. This
law states that if value added tax is charged, the
vendor must state their VAT registration number
as well as the VAT registration number of the billto party on the invoice.

N/A

Invoice/BusinessUnitID

ID of the invoiced business unit.

APICOMPANY

REQUIRED

Invoice/Currency

This field contains the ISO-code of the invoice
currency. (USD, GBP, EUR, etc.)

API-INVCURRENCY

Invoice/Custom1

Not used for export in ERP.

N/A

Invoice/Custom2

Not used for export in ERP.

N/A

Invoice/Custom3

Not used for export in ERP.

N/A

Invoice/Custom4

Not used for export in ERP.

N/A

Invoice/Custom5

Not used for export in ERP.

N/A

Invoice/DeliveryDate

This field captures the delivery date for the
goods or services stated on the invoice.

N/A

Invoice/DeliveryNote

This field captures the vendor delivery note
number if one is found on the invoice.

N/A

Invoice/Discount

This field captures a discount given by the
vendor. See IPA Administration Guide for
additional information.

N/A

Invoice/DiscountDueDate

Not used for export in ERP.

N/A

Invoice/DocumentType

INVOICE, CREDIT. This field indicates if the
incoming document is an invoice or a credit
memo.

API-INVOICETYPE

Driven by
Payment terms
Code logic

Logic in export
mapping
to set this
value to "C" if
DocumentType
= "CREDIT"
Other wise
Blank (Invoice)
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Tag

Description

Lawson API
Field

Interface
Notes

Invoice/DueDate

This field captures the due date for payment.

API-DUEDATE

If the vendor or
location does
not have a
payment terms
code assigned
and you do
not assign
a payment
terms code to
the invoice,
this field is
required

Invoice/EmployeeID

This field contains the identification number for
the user name of an employee found on the
document. This field can be used downstream
in the workflow to route the document to the
relevant person in your organization. For
example, for invoice coding and approval.

N/A

N/A

Invoice/EmployeeIndexNumber

Not used for export in ERP.

N/A

N/A

Invoice/EmployeeName

This field contains the user name of an
employee found on the document. This field can
be used downstream in the workflow to route
the document to the relevant person in your
organization. For example, for invoice coding
and approval.

N/A

N/A

Invoice/ExchangeRate

Not used for export in ERP.

N/A

N/A

Invoice/Freight

This field captures a freight charge specified
by the vendor at the header level. Freight is
typically captured at the line-item level.

N/A

Mapped at the
Line Level

Invoice/HarmonizedSalesTax

This is a type of sales tax (HarmonisedSalesTax) N/A
adopted by many Canadian provinces
that combine the traditional Goods and
Services Tax (GST) and Provincial Sales Tax
(ProvincialSalesTax) into a single tax amount.

N/A

Invoice/Iban

This number represents the international bank
account number invoice payment. It is extracted
by the system in partnership with the BIC code.

N/A

N/A

Invoice/Icms

ICMS tax is a form of sales tax that is applied
to material items in Brazil. When extracted, the
system converts this to a valid amount using
a period as the decimal separator. See IPA
Administration Guide for additional information.

N/ A

N/A

Invoice/InvalidReason

Not used for export in ERP.

N/A

N/A

Invoice/InvoiceDate

Invoice date

API-DISTRIBDATE

API-DISTRIBDATE
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Tag

Description

Lawson API
Field

Invoice/InvoiceNumber

The invoice number is a unique identifier for a
document, from the point-of-view of the supplier.

API-INVOICE

Invoice/InvoiceType

PO, NON-PO. This field indicates if an invoice is
a purchase order (PO) or a non-purchase order
(NON-PO).

N/A

N/A

Invoice/IpaClientName

Not used for export in ERP.

N/A

N/A

Invoice/IsrRetention

The ISR Retention (Impuestos sobre la Renta)
N/A
field is used to capture the ISR retention
component to withhold tax. This field can
appear on Mexican invoices. The IVA retention
component is captured in the regular withholding
tax field.

N/A

Invoice/LocalVatAmount

Not used for export in ERP.

N/A

N/A

Invoice/MexicanUuid

This field is an invoice number that is provided
by the Mexican SAT authorities. It appears as
a standard field on electronic documents. It is
36 characters long and must be captured for
government reporting purposes.

N/A

N/A

Invoice/NetAmount0

This field contains the extracted amounts on the
document that have a tax rate of zero.

N/A

N/A

Invoice/NetAmount1

This field captures an invoice subtotal amount
and it forms part of the Invoice Total. See IPA
Administration Guide for additional information.

N/A

N/A

Invoice/NetAmount2

These fields contain the extracted amounts
on the document that have tax rates specified
in TaxRate2-TaxRate4 fields. See IPA
Administration Guide for additional information.

N/A

N/A

Invoice/NetAmount3

N/A

N/A

Invoice/NetAmount4

N/A

N/A

Invoice/OrganizationName

The name of the invoiced organization in ERP

N/A

N/A

Invoice/OrganizationId

ID of the invoiced organization in ERP

N/A

N/A

Invoice/PaymentReference

This field captures vendor payment references
specified on an invoice.

N/A

N/A

Invoice/PoExtension

The PO Extension field is populated in
N/A
implementations involving JD Edwards
or PeopleSoft only. In JD Edwards
implementations, this field contains the purchase
order type. In PeopleSoft implementations, this
field contains the purchasing business unit.

N/A

Invoice/PoNumber

Purchase order number. Valid only for PO
invoices.

N/A

API-PONUMBER

Interface
Notes
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Tag

Description

Lawson API
Field

Interface
Notes

Invoice/PorNumber

The payment order reference (POR) number
is a 27-character transaction ID applied to the
invoice by the Swiss Postal Service. See IPA
Administration Guide for additional information.

N/A

N/A

Invoice/PorSubscriberNo

The payment order reference (POR) subscriber
number. See IPA Administration Guide for
additional information.

N/A

N/A

Invoice/PoType

MATERIAL, SERVICE. This field indicates if an
extracted purchase order relates to materials
or services. See IPA Administration Guide for
additional information.

N/A

Static Value
Used to
determine the
type of Export.
Not Mapped

Invoice/SiteID

Vendor site ID.

API-REMITTO-CODE

N/A

Invoice/TaxAmount1

These fields contain the tax amounts for
their corresponding Net Amounts. See IPA
Administration Guide for additional information.

API-TRANTAX-AMT

N/A

Invoice/TaxAmount2

N/A

N/A

Invoice/TaxAmount3

N/A

N/A

Invoice/TaxAmount4

N/A

N/A

Invoice/TaxRate1

These fields contain the tax rates for their
corresponding Net Amounts. See IPA
Administration Guide for additional information.

N/A

Invoice/TaxRate2

N/A

N/A

Invoice/TaxRate3

N/A

N/A

Invoice/TaxRate4

N/A

N/A

Invoice/InvoiceAmount

This field contains the total amount due for
payment on the current invoice.

API-TRANINV-AMT

REQUIRED

Invoice/VendorCity

Not used for export in ERP.

N/A

N/A

Invoice/VendorId

Vendor ID

API-VENDOR

REQUIRED

Invoice/VendorIndexId

Not used for export in ERP.

N/A

N/A

Invoice/VendorName1

Not used for export in ERP.

N/A

N/A

Invoice/VendorStreet1

Not used for export in ERP.

N/A

N/A

Invoice/VendorStreet2

Not used for export in ERP.

N/A

N/A

Invoice/VendorVat

Not used for export in ERP.

N/A

N/A

N/A
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Tag

Description

Lawson API
Field

Interface
Notes

Invoice/VendorVatRegNo

The Vendor VAT Registration Number and Bill-to N/A
VAT Registration Number are available to satisfy
a European legal/fiscal compliance ruling. This
law states that if value added tax is charged, the
vendor must state their VAT registration number
as well as the VAT registration number of the billto party on the invoice.

N/A

Invoice/VendorZip

Vendor ZIP code

N/A

N/A

Invoice/YourRef

Use this field to capture a reference number
specified on the invoice that relates to the
billable party. It can often consist of a contact
name, a reference number, or a combination of
both.

N/A

N/A

Invoice/PasswordCn

This field is used for domestic VAT invoices on
Mainland China and refers to the encrypted 4line coding block that appears in the top-right
hand quadrant of the invoice document.

N/A

N/A

Invoice/InvoiceCodeCn

This field is used for domestic VAT invoices on
Mainland China. It refers to the ten digit numeric
code that habitually appears in the top-left hand
corner of the document.

N/A

N/A

Invoice/EcmDocumentId

Document ID in the enterprise content
management system where the document has
been exported to (for ECM integration).

N/A

Would be
custom
mapped
for each
implementation

Invoice/DocumentLink

Document ID in ECM where the invoice was
exported to by APA.

N/A

Would be
custom
mapped
for each
implementation

Invoice/ErpPoType

Not used for export in ERP.

N/A

N/A

Invoice/ScanDate

Invoice import (or scan) time.

N/A

N/A

Invoice/SubTotal

Not used for export in ERP.

N/A

N/A

Invoice/Urn

Unique archive document ID (for early archiving
scenarios).

N/A

N/A

Invoice/IpaInvalidReasonCode

Not used for export in ERP.

N/A

N/A

Invoice/IpaInvalidReasonRule

Not used for export in ERP.

N/A

N/A

Invoice/IpaOrganizationName

Not used for export in ERP.

N/A

N/A

Invoice/IpaOrganizationId

Not used for export in ERP.

N/A

N/A

Invoice/PaymentComments

Not used for export in ERP.

N/A

N/A
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Tag

Description

Lawson API
Field

Interface
Notes

Invoice/PaymentMethod

Payment method.

N/A

Defaulted
by Vendor in
Lawson

Invoice/ImageExtension

Invoice image file name extension (depends on
the image type, for example, .tiff, .pdf, etc.)

N/A

Documents
are not
exported to
Lawson

Invoice/ImageBase64

Base64 encoded invoice image

N/A

Documents
are not
exported to
Lawson

Lawson AGS export mapping - Invoice Line fields
The following table explains the invoice line export fields used by the Lawson AGS.
Tag

Description

Lawson API
Field

Interface
Notes

Invoice/LineItem

Root for a line item

Lawson API
Field

Interface
Notes

Invoice/LineItem/Category

Miscellaneous charge category applied to the
N/A
invoice line item based on the extracted line item
description.

N/A

Invoice/LineItem/Description

Invoice line item description. If the line item is
paired, this description appears on the purchase
order. If the line is unpaired, this field contains
the raw text description that was read from the
invoice. For third-party freight invoices, service
invoices, and MIRA invoices where no line
items were required in the TAB section, and line
pairing was either unsuccessful for any lines,
or was not carried out, the description is set to
THIRD PARTY FREIGHT, SERVICE and MIRA
respectively.

N/A

N/A

Invoice/LineItem/Discount

Not used for export in ERP.

N/A

N/A

Invoice/LineItem/LineNumber

Line number (1..N)

MAD-LINENBRr0

Each line is
added to the
first Row
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Tag

Description

Lawson API
Field

Interface
Notes

Invoice/LineItem/LineType

One of: Item, Sales Tax, Misc. Tax, Freight,
Misc. Charge. See IpaLineType below

N/A

Not mapped,
but when used
would drive
different logic
for the line
depending on
the Type of
Line..MISC
add on cost vs
SPREAD add
on cost vs TAX

Invoice/LineItem/
MeterialNumber

Invoice line item material number. If the line
item is paired, this is populated with the material
number from the purchase order line item. If
the line is not paired, this is populated with any
values read from the invoice.

N/A

N/A

Invoice/LineItem/
OriginalLineNumber

Not used for export in ERP.

N/A

N/A

Invoice/LineItem/PoNumber

The purchase order number, and is populated
only if line pairing is successful for this item.

AOI-PONUMBER

N/A

Invoice/LineItem/Quantity

The invoice line item quantity.

MADENTEREDQTYr0

Each line is
added to the
first Row Only used in
PO

Invoice/LineItem/Total

The invoice line item total.

N/A

Not mapped calculated in
Lawson based
on unit price X
quantity

Invoice/LineItem/UnitPrice

The invoice line item unit price and it is only
populated for unpaired line items. In all other
cases, it has a value of zero.

MAD-ENTUNIT-CSTr0

Only used on
PO invoices

Invoice/LineItem/
UnitOfMeasure

Unit of measure.

ENT-BUYUOM

N/A

Invoice/LineItem/UnitOfQuantity Unit of quantity.

N/A

N/A

Invoice/LineItem/TaxAmount

Tax amount

MISC-INVAOC-AMTr0

Used in
Conjunction
with an add on
cost code - PO
Invoice Only

Invoice/LineItem/TaxRate

Tax rate Invoice line item tax rate. The
percentage rate of tax applied to the invoice line
item. If no percentage tax rate at line item level
can be ascertained, then this value is blank.

N/A

N/A

90

Kofax Invoice Processing Agility Installation Guide

Tag

Description

Lawson API
Field

Interface
Notes

Invoice/LineItem/ChargeCode

Invoice line item charge code. This is lifted from
the purchase order line item to which an invoice
line is paired.

N/A

N/A

Invoice/LineItem/ChargeCodeId Invoice line item charge code ID (only for POmatched lines). This is lifted from the purchase
order line item to which an invoice line is paired.

N/A

N/A

Invoice/LineItem/
CompanyCode

Company code that corresponds to a line item.
This is lifted from the purchase order when an
invoice line is paired.

N/A

N/A

Invoice/LineItem/ErpPoType

Not used for export in ERP.

N/A

N/A

Invoice/LineItem/MaterialGroup

This column represents the material group of the N/A
purchase order line item material. If available,
it can be mapped simply to pass this data to a
downstream ERP for a paired line item.

N/A

Invoice/LineItem/Plant

Plant ID. This is lifted from the purchase order
line item with which an invoice line is paired.

N/A

N/A

Invoice/LineItem/
PoLineNumber

The purchase order line item number. It
is populated only if line pairing has been
successful for this item.

MAD-LINENBRr0

N/A

Invoice/LineItem/Puom

The order unit of measure and it is populated
with the purchase order line item order unit
measure if the line item has been paired.

N/A

N/A

Invoice/LineItem/QtyPuom

The quantity in the order price unit of meausre.
This value is calculated during line pairing if
UOM does not correspont to PUOM.

N/A

N/A

Invoice/LineItem/
TaxableAmount

Taxable amount

APDTAXABLEAMT

Only mapped
on non-po
Invoices

Invoice/LineItem/TaxCode

The invoice line item tax code, and it is
APD-TAXpopulated using the tax determination procedure CODE
if a line item is paired.

Only mapped
on non-po
Invoices

Invoice/LineItem/Activity

Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A

Mapped in
GLSegments

Invoice/LineItem/BusinessArea

Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A

Mapped in
GLSegments

Invoice/LineItem/CostCenter

Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A

Mapped in
GLSegments
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Tag

Description

Lawson API
Field

Interface
Notes

Invoice/LineItem/DbCrIndicator

The subsequent debit or credit indicator that
N/A
indicates is the line item is a subsequent debit of
a credit line item. If this value is set to X and the
document type is INVOICE, then the line item is
treated as a subsequent debit, the amount only
and not the quantity. If the value is set to X and
the document type is CREDIT then the line item
is treated as a subsequent credit. If the value
is blank the line item is treated as a regular line
item.

N/A

Invoice/LineItem/InternalOrder

Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A

N/A

Invoice/LineItem/Network

Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A

N/A

Invoice/LineItem/ProfitCenter

Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A

N/A

Invoice/LineItem/SalesOrder

Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A

N/A

Invoice/LineItem/
SalesOrderItem

Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A

N/A

Invoice/LineItem/TaxJurCode

The invoice line tax jurisdiction code. It
represents the downstream ERP system ID for
the tax office where taxes are paid for this line
item. This is used in countries that have tax
jurisdictions for their sales tax. It is populated
only if the line item is paired.

N/A

N/A

Invoice/LineItem/WbsElement

Not used for export in ERP. Copied from
accounting data that was retrieved from ERP.
Obviously SAP only so far.

N/A

N/A

Invoice/LineItem/GlAccount

GL account string specified in APA coding
activity.

N/A

N/A
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Tag

Description

Lawson API
Field

Interface
Notes

Invoice/LineItem/GlSegment

The value of one GL segment in GL account.
This tag may repeat for the invoice line. The
number of the segments should be equal to the
number of segments specified for the account
(in GlAccount tag). Each GlSegment tag should
have two attributes: <

NON-PO/
Credit
Invoices :
APD-DISTCOMPANYr0
APD-DISACCT-UNITr0
1. · segmentNumber - the number of the
APD-DISsegment in the account structure (as
ACCOUNTr0
specified in APA configuration for the
APD-DISsegment structure
SUB-ACCTr0
ADD-ON1. · name - the segment name as specified
COST: APIfor this segment in GL structure CSV
COMPANY
MISC-ACCTExample:
<GlAccount>01-000-1100-0000-000<GlAccount> UNITr0 MISCACCOUNTr0
<GlSegment segmentNumber="1"
MISC-SUBname="Organization">01<GlSegment>
ACCTr0 PO<GlSegment segmentNumber="2"
Invoices: N/A
name="Department">000<GlSegment>
<GlSEgment segmentNumber="3"
name="Account">1100<GlSegment>
<GlSegment segmentNumber="4"
name="SubAccount">0000<GlSegment>
<GlSegment segmentNumber="5"
name="Project">000<GlSegment>

Based on
the line type
different logic
is used to map
fields

Invoice/LineItem/
ConditionCount

Not used for export in ERP. SAP only - refers to
planned conditions

N/A

N/A

Invoice/LineItem/
ConditionStepNo

Not used for export in ERP. SAP only - refers to
planned conditions

N/A

N/A

Invoice/LineItem/ConditionType Not used for export in ERP. SAP only - refers to
planned conditions

N/A

N/A

Invoice/LineItem/FreightVendor

Not used for export in ERP. SAP only - also
related to planned conditions

N/A

N/A

Invoice/LineItem/GrDocItem

The receipt line item number. It is populated only N/A
if 3-way line pairing has been successful for this
item.

N/A

Invoice/LineItem/GrDocNo

The receipt number, and is populated only if 3way line pairing is successful for this item.

N/A

N/A

Invoice/LineItem/GrDocYear

Not used for export in ERP.

N/A

N/A

Invoice/LineItem/SheetItem

Not used for export in ERP.

N/A

N/A

Invoice/LineItem/SheetNo

Not used for export in ERP.

N/A

N/A

Invoice/LineItem/
IpaBusinessUnit

PeopleSoft business unit, copied over from PO
N/A
line. APA doesn't seem to support that in its data
model?

N/A
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Tag

Description

Lawson API
Field

Interface
Notes

Invoice/LineItem/IpaLineType

Invoice line item type populated by IPA (see the
Line Type field above). This is lifted from the
purchase order line item to which an invoice line
is paired.

N/A

N/A

PeopleSoft integration
Once you have added an ERP connection and assigned it to an organization, you can use these to
integrate your PeopleSoft ERP with Invoice Processing Agility.
You can integrate your PeopleSoft ERP with Invoice Processing Agility by following these steps.
1. Extract the KofaxInvoiceProcessingAgilityConnector_For_Lawson.zip file.
a. Navigate to the ERP Integration\PeopleSoft folder.
The KofaxConnector_For_PeopleSoft.ZIP file is displayed.
b. Extract KofaxConnector_For_PeopleSoft.zip.
The KOFAX_CONNECTOR folder is extracted. Use this to copy the project.
2. Start the PeopleSoft Application Designer.
3. From the menu select Tools > Copy Project > From File.
The Copy From File : Select Project window is displayed.
4. Select the KOFAX_CONNECTOR project and follow these steps.
a. Navigate to and select the KOFAX_CONNECTOR folder.
b. Click Select to the right of the Select Project from the List Below box.
The Copy From File window is displayed.
c. Click Select All to select all definition types.
d. Click Copy.
The project and its definition types are installed.
5. Open PeopleSoft in a compatible web browser and configure the KOFAX_APA_SERVICE as follows.
a. Go to PeopleTools > Integration Broker > Integration Setup > Services.
b. Open the KOFAX_APA_SERVICE.
Information about the KOFAX_APA_SERVICE and a list of service operations is displayed.
c. Open the first of the KOFAX_APA_SERVICE service operations and click Service Operation
Security.
d. Set the PTPT1000 permission to Full Access and then click Save.
e. Repeat the previous two steps until all service operations are configured.
6. Create a PeopleSoft ERP connection as shown in Add ERP connections.
7. Add an organization to use the above ERP connection as shown in Add ERP organizations.
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8. Locate the web.config file in the web folder used by the ErpConnector service and open it with a text
editor.
a. Under <configuration><erpConnector><plugins> locate the <plugin> with the type
PeopleSoft.
Ensure that the default plugin is as follows:
<plugin type="PeopleSoft"
class="Kofax.ApAgility.ErpConnector.Plugins.PeopleSoft.PeopleSoftErpPlugin,
Kofax.ApAgility.ErpConnector.Plugins.PeopleSoft, Version=1.0.0.0,
Culture=neutral, PublicKeyToken=0a00a7449ea4c480"/>

Note There can be one PeopleSoft plugin only.
b. Under <configuration><erpConnector><connections> add a <connection> element
and sub-elements for your PeopleSoft ERP connection as follows.
<connection name="PeopleSoft" type="PeopleSoft">
<add name="url" value="https://peoplesoft:8443/PSIGW/
PeopleSoftServiceListeningConnector/PSFT_EP"/>
<add name="username" value="VP1" />
<add name="password" value="vp1" />
<add name="page_size" value="10000"/>
</connection>

For the <connection>, the name attribute must match the name of the ERP connection
defined when you added the ERP connection.
The type attribute in <connection> should match the type attribute in <plugin>.
For each of the <add> elements, provide the following values.
• url: Enter the URL to the PeopleSoft web service.
• username and password: Enter the authentication credentials for the PeopleSoft web
service.
• page_size: Enter a positive integer with the mount of master data records that are returned
by the web service for each call.
For example, if page_size is set to 1000 and the number of vendors in the PeopleSoft ERP
is 5000, the PeopleSoft ERP plugin makes 5 requests to the web service. Each time the web
service returns 1000 records of data.
Note The paths specified here much be accessible to Invoice Processing Agility
c. Save the web.config file.

Create a job for Data Import
You can import the data from the CSV files that are specified in the web.config file to your database using
a manual job by following these steps.
1. Open the Invoice Processing Agility Workspace.
2. From the Jobs menu, select Create.
The Jobs - Create page is displayed.
3. From the Category list select AP Agility.
The Process list is populated with processes for that category.
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4. From the Process list, select AP Data Import.
5. Click Create.
A message is displayed when the job is created successfully.
6. Optionally, close the Invoice Processing Agility Workspace
7. Optionally, schedule this job to run automatically.

Automate the Data Import job
If you want to ensure that the data in your web service CSV files is regularly updated, you can create a
scheduled job that does this automatically.
Alternately, import the necessary AP Agility data manually.
You can configure a scheduled job to import data on a regular basis by following these steps..
1. Launch the TotalAgility Designer.
The TotalAgility Designer Home page is displayed.
2. Optionally, log on if prompted.
3. On the Home page, click System Settings.
4. In the Manage group, select Job Schedules.
5. From the Categories list, select AP Agility.
6. Beside Job Schedules, click Add .
The Job Schedule window is displayed.
7. Enter a Name such as "Import Data."
8. Set the Category to AP Agility.
a. On the left Consume pane, select Categories.
b. From the list of categories, select AP Agility, drag, and then drop it to the Category in the Job
Schedule.
The Category is now set to AP Agility.
9. Set Active to Yes.
10. Set the Process as follows.
a. In the left panel, click Back to return to the default Consume list.
b. From the Consume pane, select Processes.
The list of processes for the Default Category are displayed.
c. Select the AP Agility category.
The list of processes are updated.
d. Drag the AP Data Import from the Cosume pane to the Process field on the Job Schedule.
The Process is updated to AP Data Import.
11. Configure the Frequency and Range of Recurrence so that the job is performed when appropriate
for your needs.
12. Click OK to save your schedule job.
Your newly created Job Schedule is now listed.
13. Optionally, Close the Job Schedules and return to the System Settings page.
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PIX installation
PIX is a Windows application that processes structured XML invoice formats and then converts them
to PDF format. This generated PDF is a rendition of the electronic content for visualization purposes.
When processed by Invoice Processing Agility, the electronic invoices data is automatically copied to the
respective invoice fields.
PIX generates the field content and a PDF based on out-of-the-box mappings for the following electronic
standards.
•
•
•
•
•
•
•
•
•
•
•

OIOUBL Invoice
OIOUBL Credit Note
OIOXML
General XML
E2B
ZUGFeRD
ebInterface
Facturae
ESXML
Finvoice
Svefaktura
Important PIX should only be installed and configured if you need to process the above types of XML
documents.

PIX also comes with a thin-client mapping correction utility that allows users to improve and advance the
default XML-to-Field mappings. For more information, see the PIX Correction Help.
PIX is comprised of two components, a server and a client. It is common for the PIX Server and the PIX
Client to be installed together on the same server. For the best results, install these together, but on a
separate machine from Invoice Processing Agility and Kofax TotalAgility.
If necessary, the PIX Server and the PIX Client can be installed on separate servers.
Note PIX supports Western character sets only. This means that it does not support CJKT characters or
extended characters required for languages such as Russian or Greek.

PIX prerequisites
Before you can install PIX, the following prerequisites are required.
• Microsoft SQL Server
• Internet Information Services with ASP.NET 3.5, ASP.NET 4.5, and WebSockets
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Install PIX client and server on the same server
In most situations, it is recommended that you install the PIX Server and the PIX Client on the same
server, but a different server to Kofax TotalAgility. If you anticipate processing documents through PIX
on a regular basis, consider installing PIX on a separate server. This ensures that PIX does not compete
with Kofax TotalAgility or Invoice Processing Agility for resources. Also, Kofax TotalAgility and Invoice
Processing Agility must both be installed before you can install PIX.
The PIX installer is included in the extracted files under the PIX_Install folder.
You can install and configure PIX by following these steps.
1. Decide where to install PIX.
Note If you are installing PIX on a separate server than Invoice Processing Agility, copy over the
PIX_Install/PixSetup.exe file from your extracted files.
2. Double-click on the PixSetup.exe file located in the PIX_Install/PixSetup.exe folder of the
extracted files.
The Kofax PIX installation window opens.
3. On the Kofax PIX Installer, select I agree to the license terms and conditions.
Leave both Install PIX Server and Install PIX Client selected.
4. Click Install.
The PIX installation starts and the PIX Server Setup Wizard is displayed.
5. Click Next twice, and stop when you get to the Database settings step.
6. If your user account does not have the necessary permission to create a database, clear the Create
database option.
A Database Administrator can create the PIX Server database manually after the PIX Server
installation finishes.
If you do have permission to create a database, select Create database and then provide the
Database server name and the Instance name if needed.
7. Click Next.
The Web site step is displayed.
8. For the best results, modify only the Log Folder, if necessary. Leave the other settings as default.
Make a note of the Port number. This is needed when configuring Invoice Processing Agility later.
9. If you do not have access to a user account that has permission to create a website, clear the Create
website option.
An Administrator can manually create the PIX Server website manually after the PIX Server
installation finishes.
If you do have access to a user account that has permission to create a website, select Create
website.
10. Click Next.
The Kofax TotalAgility Connection screen is displayed.
11. On the Kofax TotalAgility Connection screen, enter the TotalAgility URI.
For example, http://<servername>/TotalAgility/
12. Click Next.
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13.
14.

15.
16.
17.
18.
19.
20.
21.
22.
23.
24.

If you are creating a website, the User credentials screen is displayed. If you chose not to create a
website, click Next and then skip to step 15.
If you are creating a website, modify the Domain name, User name, and associated Password.
Click Next.
This user must have permissions to create a database and a web site in IIS.
The Install screen is displayed.
Click Install.
PIX Server is installed.
Click Finish.
The PIX Client Setup Wizard is displayed.
Click Next.
The Destination Folder page is displayed.
Optionally, click Change to modify where the PIX Client is installed.
Click Next.
The PIX Client settings page is displayed.
Take note of the PIX server URI as this is needed later and ensure that the Create website option is
selected.
Click Next and then Install.
The PIX Client is installed.
When the installation completes, click Finish.
A message that confirms a successful installation is displayed.
Click Close.
Configure the PIX Web.config file.

Install PIX server only
It is common to install both the PIX Server and the PIX Client on the same server. However, in certain
situation, you may not want the PIX Client and PIX Server installed on the same server. Even though the
PIX Server and the PIX Client use the same installer, it is possible to install them on separate machines.
You can install the PIX Server only by following these steps.
1. Decide where to install PIX Server.
Note If you are installing PIX on a separate server than Invoice Processing Agility, copy over the
PIX_Install/PixSetup.exe file from your extracted files.
2. Double-click on the PixSetup.exe.
The Kofax PIX installation window opens.
3. On the Kofax PIX Installer, select I agree to the license terms and conditions.
4. Clear Install PIX Client.
This installs the PIX Server only.
5. Click Install.
The PIX installation starts and the PIX Server Setup Wizard is displayed.
6. Click Next twice, and stop when you get to the Database settings step.
7. If your user account does not have the necessary permission to create a database, clear the Create
database option.

99

Kofax Invoice Processing Agility Installation Guide

8.
9.
10.

11.
12.
13.

14.
15.

16.
17.
18.

A Database Administrator can create the PIX Server database manually after the PIX Server
installation finishes.
If you do have permission to create a database, select Create database and then provide the
Database server name and the Instance name if needed.
Click Next.
The Web site step is displayed.
For the best results, modify only the Log Folder, if necessary. Leave the other settings as default.
Make a note of the Port number. This is needed when configuring Invoice Processing Agility later.
If you do not have access to a user account that has permission to create a website, clear the Create
website option.
An Administrator can manually create the PIX Server website manually after the PIX Server
installation finishes.
If you do have access to a user account that has permission to create a website, select Create
website.
Click Next.
The Kofax TotalAgility Connection screen is displayed.
On the Kofax TotalAgility Connection screen, enter the TotalAgility URI.
For example, http://<servername>/TotalAgility/
Click Next.
If you are creating a website, the User credentials screen is displayed. If you chose not to create a
website, click Next and then skip to step 16.
If you are creating a website, modify the Domain name, User name, and associated Password.
Click Next.
This user must have permissions to create a database and a web site in IIS.
The Install screen is displayed.
Click Install.
PIX Server is installed.
When the installation completes, click Finish.
A message that confirms a successful installation is displayed.
Click Close.

Install PIX client only
Although it is not common, it is possible to install the PIX Client on a different server than the PIX Server.
You can install PIX Client on a separate server by following these steps.
1. Decide where to install PIX Server.
Note If you are installing PIX on a separate server than Invoice Processing Agility, copy over the
PIX_Install/PixSetup.exe file from your extracted files.
2. Double-click on the PixSetup.exe.
The Kofax PIX installation window opens.
3. On the Kofax PIX Installer, select I agree to the license terms and conditions.
4. Clear Install PIX Server.
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This installs the PIX Client only.
5. Click Next.
The Destination Folder step is displayed.
6. Optionally, click Change to modify the installation path
7. Click Next.
8. Enter a value in the PIX server URI field.
This refers to the server name and port number recorded during the PIX Server installation.
For example, http://<servername>:<port>.
9. If you do not have access to a user account that has permission to create a website, clear the Create
website option.
An Administrator can manually create the PIX Client website manually after the PIX Client installation
finishes.
If you do have access to a user account that has permission to create a website, select Create
website.
10. Click Next.
11. Click Install.
The PIX Client installs.
12. When the installation completes, click Finish.
A message that confirms a successful installation is displayed.
13. Click Close.

Configure PIX web.config
Regardless of where the PIX Server is installed, it is necessary to configure the PIX Server web.config file
after installation. This is true if you installed both PIX Server and PIX Client on the same server, of if you
installed PIX Server on a different server to the PIX Client.
If you do not update the configuration file, it is likely that documents will fail PIX processing and that users
cannot access PIX Correction.
You can update the PIX Web.config file by following these steps.
1. Navigate to <Program Files>\Kofax\PIX\PIXServer or wherever you installed PIX.
2. Edit the Web.config file.
3. Search for the <add key "hostname" value and edit it so that the hostname uses the fullyqualified domain server name.
4. Save the Web.config file.
5. Restart the World Wide Web Publishing Service for your change to take effect.

Manually create PIX server database
When PIX Server is installed, that user may not have the necessary permissions to create the PIX Server
database. It is common for a company to restrict database creation to dedicated Database Administrators,
so they must create the database by following these steps.
1. Open Microsoft SQL Server Management Studio.
2. Create a new database.
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Name the database "SmartXML."
It is recommended that you use this name, but if you want to use another, the connection string in the
Web.config file needs updated to use this new name.
3. In Windows Explorer, navigate to where you installed PIX Server.
By default, this path is <Program Files>\Kofax\PIX\PIXServer.
4. In Microsoft SQL Server Management Server, execute the CreateTables.sql script located in the
DbScripts folder.
The script is executed and the necessary database tables are created.

Manually create PIX server website
If the user that installed PIX Server does not have the necessary permissions to install the PIX Server
Website, an Administrator can do so by following these steps.
1. Launch IIS.
2. In the Connections pane, expand http://localhost represented by your computer name.
A list of Application Pools and Sites is displayed.
3. Select and then right-click on Application Pools. Select Add Application Pool.
The Add Application Pool window is displayed.
4. In the Add Application Pool window, enter a name for your application pool such as "PIXAppPool."
a. From the .NET Framework version list, select .NET Framework v4.0.XXXXX.
b. From the Managed pipeline mode list, select Integrated.
c. Select the Start application pool immediately.

5.
6.
7.
8.
9.
10.

d. Click OK.
The new application pool is created is added to the list.
Right-click on Sites and select Add Web Site.
The Add Web Site window is displayed.
In the Site name field, enter "PixServer".
Select the newly added PIXAppPool from the Application Pool.
Browse to find the physical path of the Physical path.
By default, this is <Program Files>\Kofax\Pix\PixServer.
In the Binding group, set the Port to "53060."
This is the port number specified during installation.
Configure all other settings as appropriate for your needs and then click OK.
The new site is added to the list of sites.

Manually create PIX client website
If the user that installed PIX Client does not have the necessary permissions to install the PIX Client
Website, an Administrator can do so by following these steps.
1. Launch IIS.
2. In the Connections pane, expand http://localhost represented by your computer name.
A list of Application Pools and Sites is displayed.
3. Expand Site.
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A list of applications is displayed.
4. Right click on the Default Web Site and select Add Application.
The Add Application window is displayed.
5. In the Alias field, enter "Pix."
6. Select the "PixAppPool" from the Application Pool.
7. Browse and select <Program Files>\Kofax\Pix\PixClient\src for the Physical path.
8. Configure all other settings as appropriate for your needs and then click OK.
The new application is added to the Default Web Site list.

Configure Invoice Processing Agility to use PIX
Now that you have installed PIX you need to tell Invoice Processing Agility where it is installed and how to
access it.
You can configure Invoice Processing Agility to use PIX by following these steps.
1. Log on to the Invoice Processing Agility Workspace.
The Kofax TotalAgility Workspace for Invoice Processing Agility is loaded.
2. Click IP Agility > Settings.
The Settings page is loaded.
3. Under PIX, enter the Web client URI.
For example, http://localhost/PIX.
4. Enter the Web server URI.
This is the path recorded when you installed the PIX Client.
For example, http://localhost:53060.
5. Click Save PIX Settings.

Configure XML handling to use PIX
When you first install Invoice Processing Agility and then PIX, XML handling is done by Kofax TotalAgility.
If you want to use PIX to process and correct documents, a change to the existing configuration is
necessary. XML handling is configured in the Kofax Message Connector.
You can configure XML handling to use PIX by following these steps.
1. Click Start > Kofax > Message Connector > Message Connector Configuration.
The Message Connector Configuration window is displayed.
2. Expand the Structured (XML) Input Handling section.
A list of XML options is displayed.
3. In the Types field, replace the existing content with .none.
4. Scroll to the top and click Save.
A message confirming that your changes have saved is displayed.
5. Click Exit and restart service.
The service is restarted and the Message Connector window is closed.

103

Kofax Invoice Processing Agility Installation Guide

User Exit Assemblies
Before you can use the various User Exits, you must first implement their assemblies and then install
them. For more information on the various User Exits, see the Kofax Invoice Processing Agility Installation
Guide.

Implement User Exit assemblies
In order to make use of the available user exits, you must first implement the user exit assemblies by
following these steps.
1. Create a new project for a .NET class library.
2. Include references to the following assemblies.
• ICAL.ComponentAccess
• ICAL.Framework
• ICAL.Invoices
Note These assemblies are located in the Assemblies directory of your Invoice Processing Agility
installation files.
3. If you are using SAP, add references to the following assemblies.
• ICAL.Framework.SAP
• ICAL.Invoices.SAP
4. If you are using an Oracle database, add references to the following assemblies.
• ICAL.Framework.Oracle
5. Sign your new assembly.
This is necessary for installation to the global assembly cache.
6. Create a class that implements ICAL.Invoices.Custom.ICustomInitializer.
7. Implement the Initialize(ProjectContext) method.
8. Within the Initialize(ProjectContext) method, register your user exits in the
UserExitsRegistry that is available as the ProjectContext property.
You can implement and register as many user exits as are required.
9. Compile your assembly and give it a meaningful name such as UserExitAssembly.dll.
A DLL file is generated with the provided name.
10. Install it to the global assembly cache.
Example: Modify Vendor Addresses
You want to modify vendor addresses after that are loaded from the vendor pool or database. To do this,
implement and register the ReadVendorAddress delegate and then:
using
using
using
using

ICAL.ComponentAccess;
ICAL.Invoices;
ICAL.Invoices.Data;
ICAL.Invoices.Custom;

namespace UserExits
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{

}

public class MyUserExits : ICustomInitializer
{
public void ReadVendorAddress(IField field,
string vendorId, IVendorAddress vendorAddress)
{
// your code here
}

}

public void Initialize(ProjectContext ctx)
{
ctx.UserExits.ReadVendorAddress = ReadVendorAddress;
}

Install User Exit assembly to GAC
After compiling your assembly, it needs installed to the global assembly cache (GAC) before it is usable.
Even though you can use a tool like gacutil to install the DLL file, it is recommended that you use the
provided Install2GAC.exe tool to install your assembly to the GAC.
You can install your assembly DLL to the GAC by following these steps.
1. Copy the UserExit folder that is included with your installation files to the machine where you are
installing the assemblies.
This folder contains the Install2GAC.exe tool.
2. Copy your recently implemented User Exit Assembly dll file to the UserExit folder that you copied in
the previous step.
3. Open a command line with administrative privileges and enter the following.
Install2GAC.exe <YourUserExitAssembly>.dll
Press Enter.
Your user exit assembly is installed to the GAC.
4. Optionally, if your assembly has any dependencies to additional third-party assemblies, install those
assemblies to the GAC as well.
5. Edit the server variables in TotalAgility Designer
Depending on whether you register an assembly for the 32-bit extraction phase, or the 64-bit
validation, line pairing, and export phase, you need to set one of the following combinations in the
InvoiceProcessingAgility category.
• IPAUserExitExtractionAssembly and IPAUserExitExtractionClass
• IPAUserExitValidationAssembly and IPAUserExitValidationClass
The IPAUserExitExtractionAssembly and IPAUserExitValidationAssembly
must contain the strong name of your assembly. For example, IPAUserExitDemo,
Version=1.0.0.0, Culture=neutral, PublicKeyToken=6a3a0087b9ef9c25,
processorArchitecture=MSIL.
The IPAUserExitExtractionClass and IPAUserExitValidationClass must contain the
name of the class that implements the ICustomeInitializer interface.
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Secure connections
If you are running Kofax TotalAgility and Invoice Processing Agility using a secure connection (https://), it
is necessary to make some changes to the web.config file so that the Solution Configuration Manager can
also run in secure mode. The web.config file is installed alongside the Solution Configuration Manager.
To ensure that the service connection is running in a secure mode, edit the following line:
<security mode="TransportCredentialOnly">

By changing it as follows:
<security mode="Transport">

For the resource service connection the address must be updated for a secure connection. The following
example shows a non-secure connection.
<client>
<!--For https resource service connection please change the address value to the
https url with the server name e.g : https://servername/TotalAgility/Services/Sdk/
ResourceService.svc" -->
<endpoint name="SdkResourceServiceEndpoint" address="http://localhost/
TotalAgility/Services/Sdk/ResourceService.svc"
binding="basicHttpBinding"
bindingConfiguration="BasicHttpBinding_Service"
contract="ResourceServiceReference.IResourceService"/>
<endpoint address="http://localhost/TotalAgility/Services/Sdk/
DocumentTypeVariantService.svc"
binding="basicHttpBinding" bindingConfiguration="BasicHttpBinding_Service"
contract="DocumentTypeVariantServiceReference.IDocumentTypeVariantService"
name="SdkDocumentTypeVariantServiceEndpoint" />
</client>

Note The localhost need to be updated with the server name to which the SSL certificate is assigned.
To make this a secure connection, edit the path so that the address starts with https:// instead of an http://
prefix. The updated example is as follows:
<client>
<!--For https resource service connection please change the address value to the
https url with the server name e.g : https://servername/TotalAgility/Services/Sdk/
ResourceService.svc" -->
<endpoint name="SdkResourceServiceEndpoint" address="https://localhost/
TotalAgility/Services/Sdk/ResourceService.svc"
binding="basicHttpBinding"
bindingConfiguration="BasicHttpBinding_Service"
contract="ResourceServiceReference.IResourceService"/>
<endpoint address="https://localhost/TotalAgility/Services/Sdk/
DocumentTypeVariantService.svc"
binding="basicHttpBinding" bindingConfiguration="BasicHttpBinding_Service"
contract="DocumentTypeVariantServiceReference.IDocumentTypeVariantService"
name="SdkDocumentTypeVariantServiceEndpoint" />
</client>
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Restart the services
You need to restart the following services to complete the installation of Invoice Processing Agility.
• World Wide Web Publishing Service
• Kofax TotalAgility Core Worker Service
• Kofax Transformation Server
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Change Invoice Processing Agility
It is possible to remove or change the features that are installed on your server. This is possible using the
same installer that you used to install Invoice Processing Agility in the first place. In fact, if you run the
installer on a server where any component of Invoice Processing Agility is installed already, the installer
only lets you Change, Repair, or Remove Invoice Processing Agility.
You can also use the Change option to update any configuration settings as necessary. For example, the
Web Server where the Solution Configuration Manager is installed is replaced with a newer server. As a
result, it is necessary to install and configure the Solution Configuration Manager again.
You can change your Invoice Processing Agility installation by following these steps.
1. Navigate to your extracted files and open the Installer folder.
The contents of the Installer folder are displayed.
2. Double-click on the Kofax Invoice Processing Agility installer to begin the Setup Wizard.
The Setup Wizard recognizes that Invoice Processing Agility is installed already.
3. Click Next.
The Change, Repair, or Remove Installation window is displayed.
4. Click Change and then click Next.
The Prerequisites Setup Wizard step is displayed along with any information about missing
prerequisites.
5. The information displayed on the Prerequisites step is relevant if you are installing the listed
components only.
For example, if you receive a message that the SAP .NET connector is missing, but you are not
using SAP, ignore this message. However, if you are using one of the components listed, click
Cancel and then Finish to exit the Setup Wizard, install the required prerequisite, and then restart
the installer. Otherwise, click Next.
If you did not install the necessary prerequisites, the corresponding options are not available for
installation.
The Custom Setup Wizard step is displayed along with a list of installed features.
6. To remove an already installed feature, change it so that the Entire feature will be unavailable. To
install a feature that was previously not included, or make changes to an already installed feature,
select Will be installed on local hard drive.
Once you select the necessary components, click Next.
Use the links below to change or install each of the following features as appropriate for your
installation.
• Invoice Processing Agility assemblies
• Invoice Processing Agility client database connection
• Kofax TotalAgility Integration/package
• The Solution Configuration Manager
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Once you have made the necessary changes, click Change.
A progress indicator shows the progress of the Kofax Invoice Processing Agility installation.
7. Click Finish.
Optionally, select the View Installation Log option. This opens the log file once the installer is
closed.
The installer closes and if selected, the log file opens.

Remove a feature
If you no longer need an Invoice Processing Agility feature, you can remove that individual feature rather
than the entire product.
For example, you have the Solution Configuration Manager installed on your computer but you have a
new dedicated Web Server. You can use the installer to remove the Solution Configuration Manager so
that you do not have to do this manually. You can then run the installer in custom mode on your new Web
Server to install the Solution Configuration Manager there.
Another example would be a change to your ERP system. If you previously used Oracle but now use
SAP, you can remove the Oracle assemblies and add the SAP assemblies, assuming that the SAP
prerequisites are installed.
Note If you do remove assemblies, this does not remove the prerequisites themselves. You need to
remove these separately.
You can remove an Invoice Processing Agility feature by following these steps.
1. Navigate to your extracted files and open the Installer folder.
The contents of the Installer folder are displayed.
2. Double-click on the Kofax Invoice Processing Agility installer to begin the Setup Wizard.
The installer opens and enables you to remove or change your Invoice Processing Agility installation.
3. Click Next.
The Change, Repair, or Remove Installation window is displayed.
4. Click Change.
The Prerequisites Setup Wizard step is displayed along with any information about missing
prerequisites.
5. The information displayed on the Prerequisites step is relevant if you are installing the listed
components only.
For example, if you receive a message that the SAP .NET connector is missing, but you are not
using SAP, ignore this message. However, if you are using one of the components listed, click
Cancel and then Finish to exit the Setup Wizard, install the required prerequisite, and then restart
the installer. Otherwise, click Next.
If you did not install the necessary prerequisites, the corresponding options are not available for
installation.
The Custom Setup step is displayed indicating the features that are already installed.
6. For the feature or features that you are removing, select Entire feature will be unavailble and then
click Next.
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The Ready to Change Kofax Invoice Processing Agility 1.1.0 Setup Wizard step is displayed.
7. Click Change.
A progress indicator shows the progress of the Kofax Invoice Processing Agility installation.
8. Click Finish.
Optionally, select the View Installation Log option. This opens the log file once the installer is
closed.
The installer closes and if selected, the log file opens.

Add a feature
Because environments change regularly, it is possible to add an Invoice Processing Agility at a later time if
necessary.
For example, if you use SAP and the prerequisites were not installed when you first installed Invoice
Processing Agility, you can go back at a later time and install this feature once the necessary prerequisites
are installed.
Another example is changing your ERP system. You can install the necessary prerequisites for Oracle or
MarkView and then install their required assemblies.
You can add a feature to Invoice Processing Agility by following these steps.
1. Navigate to your extracted files and open the Installer folder.
The contents of the Installer folder are displayed.
2. Double-click on the Kofax Invoice Processing Agility installer to begin the Setup Wizard.
The installer opens and enables you to remove or change your Invoice Processing Agility installation.
3. Click Next.
The Change, Repair, or Remove Installation window is displayed.
4. Click Change.
The Prerequisites Setup Wizard step is displayed along with any information about missing
prerequisites.
5. The information displayed on the Prerequisites step is relevant if you are installing the listed
components only.
For example, if you receive a message that the SAP .NET connector is missing, but you are not
using SAP, ignore this message. However, if you are using one of the components listed, click
Cancel and then Finish to exit the Setup Wizard, install the required prerequisite, and then restart
the installer. Otherwise, click Next.
If you did not install the necessary prerequisites, the corresponding options are not available for
installation.
The Custom Setup step is displayed indicating the features that are already installed.
6. For any feature that you want to install that is not already installed, select Will be installed on local
hard drive and then click Next.
The Ready to Change Kofax Invoice Processing Agility 1.1.0 Setup Wizard step is displayed.
7. Click Change.
A progress indicator shows the progress of the Kofax Invoice Processing Agility installation.
8. Click Finish.
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Optionally, select the View Installation Log option. This opens the log file once the installer is
closed.
The installer closes and if selected, the log file opens.
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Repair Invoice Processing Agility
If your Invoice Processing Agility installation fails because some files are corrupted or missing, you can
run the repair option from the installer.
This repair option reinstalls some of the features that you originally installed, such as assemblies and
Solution Configuration Manager IIS and Website settings.
The repair does not however, recreate the Invoice Processing Agility client database, the Solution
Configuration Manager database, nor does it re-install the Kofax TotalAgility Package. This ensures that
you do not lose any configurations made up to this point.

How to repair Invoice Processing Agility
In most cases the repair occurs automatically. All features are updated and repaired without user
interaction.
However, if you have the Solution Configuration Manager installed, and depending on how you installed
this in the first place, some manual user interaction may be required. The following two situations require
manual interaction.
• You selected Custom Account for the Pool Identity when setting up the Solution Configuration Manager
website.
• You selected SQL Server Authentication when creating the Solution Configuration Manager database.
In either of the above scenarios you are asked to provide the user credentials for the specified user
account before you can repair your Invoice Processing Agility installation.
You can repair Invoice Processing Agility by following these steps.
1. Navigate to your extracted files and open the Installer folder.
The contents of the Installer folder are displayed.
2. Double-click on the Kofax Invoice Processing Agility installer to begin the Setup Wizard.
The installer opens and enables you to remove or change your Invoice Processing Agility installation.
3. Click Next.
The Change, Repair, or Remove Installation window is displayed.
4. Click Repair.
Depending on how the Solution Configuration Manager is configured, two additional steps may be
displayed before you can finalize the repair of your installation.
a. Optionally, if the Solution Configuration Manager uses a Custom Account for the Pool Identity,
enter the Custom Account details and then click Next.
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b. Optionally, if the Solution Configuration Manager uses SQL Server Authentication for its
database, enter the account details and then click Next.
The Ready to Repair Invoice Processing Agility 1.1.0 Setup Wizard step is displayed.
5. Click Repair.
A progress indicator shows the progress of the Kofax Invoice Processing Agility installation.
6. Click Finish.
Optionally, select the View Installation Log option. This opens the log file once the installer is
closed.
The installer closes and if selected, the log file opens.
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Upgrade considerations
You can upgrade from an older version of Invoice Processing Agility to the next released version while
maintaining the customizations to the Invoice Processing Agility process. The Invoice Processing Agility
product activities are presently implemented as sub-processes. These activities are automatically
upgraded to the new package that is installed.
You must not modify any processes, business rules, or forms with the exception of the following artifacts.
• Classification Group
• InvoiceProcessingAgility
• Document Group
• InvoiceProcessingAgility
• Forms
• CaptureDocument_Scan
• GeneralWorkQueue
• Invoices_Validation
• RescanRejectedDocs_Re Scan_Scan
• XMLDisplay
• IPA_SessionTimeout
• Processes
• CaptureDocument
• ParkNAIDocuments
• PostLinePairing
In most cases, changes to the Invoice Processing Agility project in Transformation Designer are required.
This is because your organization may have specific requirements that are not available in the out-of-thebox solution.
The following guidelines should be met when customizing your project. These guidelines ensure that any
customizations are still available in future versions of Invoice Processing Agility.
Tip Keep notes of all changes made to a project. This is so that you can manually redo them if
necessary, or to confirm if a future upgrade and merge are successful.
• It is important that you do not delete, move, or rename the following.
• Classes
• Field Groups
• Fields
• Locators
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•
•
•
•

•

If you delete one of these items and then add it back, the internal ID is no longer the same, so the item
does not behave as it should.
All new Classes, Field Groups, Fields, or Locators should have a name that will not conflict with future
releases of the solution. For example, add the "Custom_" prefix to all new items.
Do not remove any Databases, Dictionaries, Recognition Profiles, Table Models, or other dependent
settings.
You can modify Recognition Profiles by adding an additional language.
Add script below the marking line that says 'Modify script only below this line. Any
modifications above this line can cause problems with the package and are not included in a future
merge.
In script, refer to lookup fields and other items by their name and not by their index IDs. This is because
the indexes can change and the names are not likely to change.
Note Document sets and training sets are not included in the merge process. This means that if you
have documents in either the classification training set or the extraction training set, make a copy of
these outside of the project folder to ensure that they are not lost during the merge. You can copy them
back after the merge.

Upgrade Invoice Processing Agility
If you already have a version of Invoice Processing Agility installed already, it is possible to upgrade this
by running the installer.
Note Ensure that Kofax TotalAgility is upgraded to version 7.5.0 before upgrading Invoice Processing
Agility.
However, if you have already added the Invoice Processing Agility client database and the Solution
Configuration Manager database, these do not need installed again. Instead, you need to run an upgrade
script.
You can upgrade Invoice Processing Agility by following these steps.
1. Open the Internet Information Services Manager (IIS).
2. In the Connections pane, expand http://localhost represented by your server name.
A list of Application Polls and Sites is displayed.
3. Expand Sites and then Default Web Site.
A list of sites and applications is displayed.
4. Right-click on the application created when you installed the Solution Configuration Manager and
click Remove.
When prompted to confirm the removal, click Yes.
The application is removed from the list.
5. Select Application Pools.
A list of Application Pools is displayed.
6. If a dedicated application pool was created for the Solution Configuration Manager, right-click on that
application pool and select Remove.
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When prompted to confirm the removal, click Yes.
The application pool is deleted.
7. Optionally, close the Internet Information Services Manager (IIS).
8. Open Microsoft SQL Mangement Studio and select the IPASCM database.
If you provided an alternative name for the Solution Configuration Manager database during install,
select that instead.
9. Right-click the database and select Delete.
When prompted to confirm the removal, click OK.
The database is removed and the Solution Configuration Manager is now ready for installation.
10. Optionally, close the Microsoft SQL Mangement Studio.
11. Navigate to your extracted files and open the Installer folder.
The contents of the Installer folder are displayed.
12. Double-click on the Kofax Invoice Processing Agility installer to begin the Setup Wizard.
The installer opens and calculates if there is enough space on disk for the installation.
13. Once the Install Wizard confirms that there is enough disk space, click Next.
The End-User License Agreement Setup Wizard step is displayed.
14. Select I accept the terms in the License Agreement and then click Next.
The Prerequisites Setup Wizard step is displayed along with any information about missing
prerequisites.
15. The information displayed on the Prerequisites step is relevant if you are installing the listed
components only.
For example, if you receive a message that the SAP .NET connector is missing, but you are not
using SAP, ignore this message. However, if you are using one of the components listed, click
Cancel and then Finish to exit the Setup Wizard, install the required prerequisite, and then restart
the installer. Otherwise, click Next.
If you did not install the necessary prerequisites, the corresponding options are not available for
installation.
The Choose Setup Type Setup Wizard step is displayed.
16. Select Custom and then click Next.
It is also possible to select the Full setup type if you are installing all features. Follow the instructions
on screen until you come to the Invoice Processing Agility Client Database Connection Setup
Wizard step and then continue with step 18.
The Custom Setup step is displayed along with a list of available components.
17. Select the features you are installing and click Next.
The Invoice Processing Agility Client Database Connection Setup Wizard step is displayed.
18. Since you do not need to create the client database a second time, click Next.
The Setup Wizard detects if a client database exists already and then runs an upgrade script
automatically.
The Kofax TotalAgility Connection Setup Wizard step is displayed.
19. On the Kofax TotalAgility Connection step, enter the following information.
a. If the default Kofax TotalAgility URL that is provided is not correct, update the TotalAgility URL.
For example, http://<Server name>/TotalAgility/.
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b. Select your Authentication type from one of the following options.
• Authentication by username and password.
• Provide Session ID.
This ID is found by navigating to the TotalAgility Designer home page. Select System
Settings > Settings.
• Windows authentication.
Is you are using Authentication by username and password enter a User name and User
password.
If you are using Provide Session ID, enter the Session ID.
If you are using Windows authentication, no further action is required.
c. Click Test connection to ensure that your information is correct. If not, repeat the previous
steps and try again.
d. Once your connection test is successful, click Next.
The Solution Configuration Manager Setup Wizard step is displayed.
20. On the Solution Configuration Manager website window, enter the following information.
Note A default set of values is presented by this step of the installer. If you do not want to use the
default values, enter or select alternative values.
a. Optionally, enter an alternate Web Site.
Important A web site must exist in IIS before it can be added here. All other items are created
dynamically.
b. Optionally, enter a different Virtual Directory.
c. Optionally, enter a different Application Pool.
d. Optionally, select a Pool Identity.
If you select Custom Account, enter a User name, User domain, and the corresponding User
password.
e. Click Next.
The Solution Configuration Manager Database Setup Wizard step is displayed.
21. On the Solution Configuration Manager Database step, enter the following information.
Note A default set of values is presented by this step of the installer. If you do not want to use the
default values, enter or select alternative values.
a. Optionally, enter an alternate Database name.
b. Optionally, enter an alternate Server name.
c. Select your Authentication Type from one of the following.
• Windows Authentication
• SQL Server Authentication
Tip Ensure that the user specified here has at least db_owner permissions.
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d. If you selected SQL Server Authentication, enter a User name and User password.
e. Click Test connection to ensure that your information is correct. If not, repeat the previous
steps and try again.
f. Once your connection is successful, click Next.
The Ready to Install Kofax Invoice Processing Agility 1.1.0 Setup Wizard step is displayed.
22. On the Ready to install Kofax Invoice Processing Agility 1.1.0 step click Install to proceed with
your installation.
Otherwise, click Back to return to previous steps in the Setup Wizard.
A progress indicator shows the progress of the Kofax Invoice Processing Agility installation.
23. Click Finish.
Optionally, select the View Installation Log option. This opens the log file once the installer is
closed.
The installer closes and if selected, the log file opens.
24. Now that the installer has successfully upgraded Invoice Processing Agility, you must now configure
your installation so that it works in your environment.

Upgrade Invoice Processing Agility Configurations
After upgrading Invoice Processing Agility, it is still necessary to perform several configuration steps.
However, after an upgrade, you do not need to perform some of the configurations that are required after
an initial install.
As a result, after upgrading Invoice Processing Agility, configure your upgraded installation by following
these steps.
1. Update the Kofax TotalAgility theme form style sheet
2. If using Windows Authentication, configure the authentication type as well as the session timeout
behavior.
3. Configure the Solution Configuration Manager.
4. Optionally, if you are integrated with MarkView it is necessary to execute the new
UpdateMarkview.sql script against the Invoice Processing Agility client database.
5. Optionally, if you are integrated with AP Agility and it has also been upgraded, it is necessary to
execute the UpdateAPAgility.sql script against the Invoice Processing Agility client database.
6. Optionally, merge the Transformation Designer project. Perform this merge if you made any
modifications other than database CSV file locations to the project.
7. Optionally, if you are using an ERP, configure the ERP connection.
8. Optionally, if you are using PIX, do the following.
Important Whether you installed PIX Client and PIX Server on the same machine or not, it is
necessary to remove the PIX database and website wherever they are installed before you
upgrade to a newer version for PIX.
a. Remove the PIX database and website.
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b. Depending on your PIX configuration, do one or more of the following.
• Install PIX client and server on the same server
• Install PIX server only
• Install PIX client only
c. Update the PIX settings on the Settings.

Merge Transformation Designer project customizations
If you made any changes to the Transformation Designer project in a previous version, those changes
must be merged to the upgraded project. For example, merge the project if you added any custom items
such as fields, field groups, classes, or locators.
Note If the only changes made to the Transformation Designer project were the database CSV paths,
these are now handled automatically. You do not need to merge the project in this case because the
path you provided in an earlier version is no longer applicable.
You can merge the Transformation Designer project by following these steps.
1. Open Transformation Designer and then open the InvoiceProcessingAgility project.
The project opens.
2. Click on the Kofax button and then select Merge Local Changes from Previous Version.
The Choose Version with Desired Local Changes window is displayed.
3. Select the version that contains the local changes and then click OK.
In many cases this is the version with the highest version number.
After the two projects are compared the Select Items to Merge window is displayed.
4. All highlighted items represent a change in the project. These may be development changes or
manual changes made by you in the previous version of Invoice Processing Agility.
Review each change and select those to include in the upgrade. Hover over the information icon to
get more details about the specific changes between the project versions.
5. Select individual changes or click Select all to select all changes and then click OK.
The merge is performed and a completion message is displayed.
6. Click OK.
The message window closes and you are returned to your newly merged project.
7. Optionally, make further modifications to the project if needed.
8. From the Project tab, click Release Project.
The project is saved, released, and ready for use in production.

Remove PIX database and website
Before you can upgrade PIX, it is necessary to first remove the PIX database and website.
Note You need the PIX installer used to install the previous version of PIX.
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You can remove PIX using the PIX installer by following these steps.
1. Double-click on the PixSetup.exe file located in the PIX_Install/PixSetup.exe folder of the
extracted files from the previous release.
The Kofax PIX installation window opens. It recognizes that PIX is already installed, with options to
Repair and Uninstall.
2. On the Kofax PIX Installer, click Uninstall.
The PIX Server and PIX Client web sites, if installed, are removed.
3. Click Close.
The PIX installer closes.
4. Optionally, if the PIX client is installed on a separate machine, run the installer there and click
Uninstall.
5. Open Microsoft SQL Mangement Studio and select the SmartXML PIX database.
6. Right-click and select Delete.
When prompted to confirm the removal, click OK.
The database is removed and PIX is now ready for installation.
7. Optionally, close Microsoft SQL Mangement Studio.
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Remove Invoice Processing Agility
If you no longer want Invoice Processing Agility installed on your server, you can remove several
components from your server using the installer.
Specifically, the following components are removed.
• The Invoice Processing Agility assemblies.
• The Solution Configuration Manager web site and associated files.
There are some Invoice Processing Agility components that are not removed using the installer. These
include:
• The Invoice Processing Agility Client database.
• The Solution Configuration Manager database.
• The Kofax TotalAgility package.
You can remove the two databases manually by using the SQL Server Management Studio. However,
Kofax recommends that you do not remove the Kofax TotalAgility package. Leaving the package installed
does not affect Kofax TotalAgility performance.
You can remove several Invoice Processing Agility components by following these steps.
1. Double-click on the Kofax Invoice Processing Agility installer.
The installer opens.
2. Click Next.
The Change, Repair, or Remove Installation window is displayed.
3. Click Remove.
The Ready to Remove Kofax Invoice Processing Agility 1.1.0 window is displayed.
4. Click Next.
Invoice Processing Agility is removed and the completion window is displayed.
5. Optionally, select View Installation Log to see the log file.
6. Click Finish.
The Installer closes and several components of Invoice Processing Agility are no longer installed on
your server. You can remove the remaining components manually if you want.
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Access Invoice Processing Agility
documentation
By default, the Invoice Processing Agility documentation is available online. However, if necessary, you
can also configure Invoice Processing Agility to use help offline.

Default online documentation
The full documentation set for Invoice Processing Agility is available from https://docshield.kofax.com/
Portal/Products/IPA/110-off8bue7sx/IPA.htm.
To launch the online help for the installed version of the product, click on the IP Agility menu, select Help,
and then select the appropriate menu option.

Configure offline documentation
To access the documentation offline, download it from the Kofax Fulfillment Site. Since Invoice Processing
Agility supports five languages, each language has a separate documentation compressed file.
For example, KofaxInvoiceProcessingAgilityDocumentation_1.1.0_EN.zip for English or
KofaxInvoiceProcessingAgilityDocumentation_1.1.0_DE.zip for German.
Offline help for Invoice Processing Agility is available in English, German, French, Spanish, and
Portuguese (Brazilian).
Note The compressed files for languages other than English do not contain the help for the Solution
Configuration Manager or PIX Correction. As a result, access to the Solution Configuration Manager and
PIX Correction help offline must be done using the English compressed file. The English content also
includes a print folder that contains the Kofax Invoice Processing Agility Installation Guide, Kofax Invoice
Processing Agility Administrator's Guide, and the Kofax Invoice Processing Agility Release Notes.
Because of this, we recommend that you install the English content as well as any of other available
languages.
You can configure Invoice Processing Agility to use offline help by following these steps.
1. To configure the user help so that it is available offline, log on to the Invoice Processing Agility
Workspace.
For example, http://<ServerName>/TotalAgility/forms/ipa/.
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The Kofax TotalAgility Workspace for Invoice Processing Agility is loaded.
2. From the menu, select IP Agility > Settings.
The Settings page opens.
3. In the Help section, edit the Help Base URL so that it points to a location visible by IIS.
For example, http://localhost/TotalAgility/Help. This path is also used by TotalAgility for
its own offline help.
If you want to use a different path, alter this link and subsequent paths accordingly.
4. Click Save Help Settings.
Your changes are saved and the offline documentation mechanism is in place and ready for content.
5. Download the Invoice Processing Agility Documentation 1.1.0 ZIP file for English and any of the
other available languages that you are using from the Kofax Fulfillment Site.
6. Extract the contents of the compressed documentation files.
7. Copy the extracted language files to the following location.
\\TotalAgility\Agility.Server.Web\Help\IPA\<Language>\help.
Create the IPA and <Language> folders as necessary.
Optionally, copy the contents of the English extracted print folder to:
\\TotalAgility\Agility.Server.Web\Help\IPA\en_US\print.
For example, if you installed both the English and the Spanish help, the resulting file structure under
\\TotalAgility\Agility.Server.Web\Help\IPA\ should be as follows.

8. Return to the to the Invoice Processing Agility Workspace and select IP Agility > Settings.
9. From the menu, test each of the following.
• IP Agility > Help > Scan
• IP Agility > Help > Validation
• IP Agility > Help > PIX Correction
• IP Agility > Help > Line Pairing Correction
• IP Agility > Help > Solution Configuration Manager
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If the main language of your web browser is set to one of the supported languages, the user interface
and documentation for Invoice Processing Agility appear in that language automatically. For any
other language, and for the administrative documentation, it defaults to English.
If you have multiple languages configured, change your browser language to test each language.
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